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1 Safety precautions

Before using your printer, read the following safety precautions to make sure you use the equipment safely.

You are expected to have the appropriate technical training and experience necessary to be aware of hazards
to which you may be exposed in performing a task, and take appropriate measures to minimize the risks to
yourself and to other people.

General safety guidelines
● Refer to the installation instructions before connecting the printer to the supply.

● There are no operator-serviceable parts inside the printer except those covered by HP's Customer Self
Repair program (see http://www.hp.com/go/selfrepair/). Refer servicing of other parts to qualified
service personnel.

● Turn off the printer, unplug both power cords from the power outlets, and call your service
representative in any of the following cases.

◦ The power cord or plug is damaged.

◦ Liquid has entered the printer.

◦ There is smoke or an unusual smell coming from the printer.

◦ The printer has been dropped or the drying or curing module damaged.

◦ The printer's built-in Residual Current Circuit Breaker (Ground Fault Circuit Interrupter) has been
repeatedly tripped.

◦ The printer is not operating normally.

● Turn off the printer and unplug both power cords from the power outlets in either of the following
cases.

◦ During a thunderstorm

◦ During a power failure

Electrical shock hazard
WARNING! The drying and curing modules operate at hazardous voltages capable of causing death or
serious personal injury.

The printer uses two power cords. Unplug both power cords before servicing the printer. The printer must be
connected to earthed mains outlets only.

To avoid the risk of electric shock:
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● Do not attempt to dismantle the drying and curing modules or the electrical control cabinet.

● Do not remove or open any other closed system covers or plugs.

● Do not insert objects through slots in the printer.

● Test the functionality of the Residual Current Circuit Breaker (RCCB) every 6 months.

Heat hazard
The drying and curing subsystems of the printer operate at high temperatures and can cause burns if
touched. To avoid personal injury, take the following precautions.

● Do not touch the internal enclosures of the printer's drying and curing modules. Even after opening the
window latch that disconnects drying and curing power, the internal surfaces could be hot.

● Take special care when accessing the substrate path.

Fire hazard
The drying and curing subsystems of the printer operate at high temperatures. Call your service
representative if the printer's built-in Residual Current Circuit Breaker (Ground Fault Circuit Interrupter) is
repeatedly tripped.

To avoid the risk of fire, take the following precautions.

● Use the power supply voltage specified on the nameplate.

● Connect the power cords to dedicated lines, each protected by a branch circuit breaker according to the
rating of the wall socket. Do not use a power strip (relocatable power tap) to connect both power cords.

● Use only the power cords supplied by HP with the printer. Do not use a damaged power cord. Do not use
the power cords with other products.

● Do not insert objects through slots in the printer.

● Take care not to spill liquid on the printer.

● Do not use aerosol products that contain flammable gases inside or around the printer.

● Do not block or cover the openings of the printer.

● Do not attempt to dismantle the drying or curing module, or the electrical control cabinet.

● Ensure that the operating temperature of the substrate loaded recommended by the manufacturer is
not exceeded. If this information is not available from the manufacturer, do not load substrates that
cannot be used at an operating temperature under 125°C (257°F).

● Do not load substrates with auto-ignition temperatures below 300°C (572°F). See note below.

NOTE: Test method based on EN ISO 6942:2002; Evaluation of materials and material assemblies when
exposed to a source of radiant heat, method B. The test conditions, to determine the temperature when the
substrate starts ignition (either flame or glow) were: Heat flux density: 30 kW/m², copper calorimeter, K type
thermocouple.

Mechanical hazard
The printer has moving parts that could cause injury. To avoid personal injury, take the following precautions
when working close to the printer.
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● Keep your clothing and all parts of your body away from the printer's moving parts.

● Avoid wearing necklaces, bracelets and other hanging objects.

● If your hair is long, try to secure it so that it will not fall into the printer.

● Take care that sleeves or gloves do not get caught in the printer's moving parts.

● Avoid standing close to the fans, which could cause injury and could also affect print quality (by
obstructing the air flow).

● Do not touch gears or moving rolls during printing.

Heavy substrate hazard
Special care must be taken to avoid personal injury when handling heavy substrates.

● Handling heavy substrate rolls may require more than one person. Care must be taken to avoid back
strain and/or injury.

● Consider using a forklift, pallet truck or other handling equipment.

● When handling heavy substrate rolls, wear personal protective equipment including boots and gloves.

Ink handling
Your printer does not use solvent inks and does not have the traditional problems associated with them.
However, HP recommends that you wear gloves when handling ink system components.

Warnings and cautions
The following symbols are used in this manual to ensure the proper use of the printer and to prevent the
printer from being damaged. Follow the instructions marked with these symbols.

WARNING! Failure to follow the guidelines marked with this symbol could result in serious personal injury
or death.

CAUTION: Failure to follow the guidelines marked with this symbol could result in minor personal injury or
damage to the product.

Warning labels
Label Explanation

Risk of burns. Do not touch the internal enclosures of drying and
curing modules of the printer.

Risk of burns. Do not touch the drying enclosure of the printer.
Even after opening the window latch, which disconnects the
power to the drying and curing modules, the internal surfaces
could be hot.
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Label Explanation

Electric shock hazard. The printer has two input power cords. A
voltage is still present in the drying and curing modules after the
main switch is turned off. There are no operator-serviceable parts
inside the printer. Refer servicing to qualified service personnel.
Disconnect all power cords before servicing.

See installation instructions before connecting to the supply.
Ensure that the input voltage is within the printer's rated voltage
range. The printer requires two dedicated lines, each protected by
a branch circuit breaker according to the rating of the wall socket
outlet. Use only earthed mains outlets and the power cords
supplied by HP with the printer.

Risk of trapped hands. Do not push the roll while loading. Lift the
loading table to ease the spindle into the printer.

Risk of trapped fingers. Do not touch spindle gears while moving.

Do not put objects on top of the printer. Do not cover the top
fans.

You are recommended to wear gloves when handling ink
cartridges, printhead cleaning cartridges and the printhead
cleaning container.
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2 Printer status

Check printer status
You can check the current status of the printer in the following ways:

● The Embedded Web Server displays the status of the printer, the loaded substrate and the ink system.

To use the Embedded Web Server, enter your printer's URL into your Web browser. The URL is displayed
on the printer's front panel: it is http://192.168.1.1 in the example below:

● The front panel displays the ink levels by default; otherwise, you can see the ink levels by selecting the
the Ink System icon . In addition, the most important current alert, if any, is displayed in the front
panel.

Check the status of the ink system
1. Access the Embedded Web Server (see above).

2. Go to the Supplies page on the Main tab.

The Supplies page shows you the status of the loaded substrate, the ink cartridges, the printheads, the
heaters, the printhead cleaning kit, the ink funnel and the ink maintenance kit.

The traffic light shows whether maintenance is required. For further information, click View details.
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Check the status of the ink cartridges
To view the ink levels in your ink cartridges, go to the printer's front panel and select the  icon.

Click the + sign for more details, or use the ink menu.

You can also view the status of the ink cartridges in the Embedded Web Server.

Ink menu procedure
1. On the front panel, select the  icon, then select Ink cartridge information.

2. Select the cartridge about which you want information.

3. The front panel shows the following information:

● Color

● Product name

● Product number

● Serial number

● Status

● Ink level, if known

● Total ink capacity in milliliters

● Expiration date

● Warranty status

● Manufacturer

Check the status of a printhead
The printer automatically checks and services the printheads after each print. Follow these steps to get more
information on your printheads.

1. On the front panel, select the  icon, then select Printhead information.

2. Select the printhead for which you want to see information.

3. The front panel shows the following information:

● Colors

● Product name

● Product number

● Serial number

● Status (see Front-panel error messages on page 79)

● Volume of ink it has used

● Warranty status

You can also use the Embedded Web Server to check the printhead status and the warranty status.
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NOTE: If the warranty status is See warranty note, this indicates that non-HP ink is being used. Printer
service or repairs required as a result of using "non-HP" ink are not covered under warranty. See the Legal
Information document for detailed warranty implications.

Check the file system
It is possible to check the integrity of the file system on the printer's hard disk, and automatically correct any
errors. You are recommended to do this about once every six months, or if you notice any trouble in
accessing files on the hard disk.

To execute the file system check, go to the front panel and select the  icon, then select File system check.

If the printer is aware of damage to the file system, for instance after a severe software problem, it may start
a file system check automatically. This can take about half an hour.

Printer alerts
The printer can communicate two types of alerts:

● Errors: When the printer is unable to print.

● Warnings: When the printer needs attention for an adjustment, such as a calibration, preventive
maintenance or ink cartridge replacement.

Printer alerts appear in the front panel and in the Embedded Web Server. In some cases, the printer may also
make an audible beep to draw your attention to the alert. If you do not want to hear the beeps, you can
disable them from the front panel.

● Front-panel display: The front panel shows only one alert at a time, which is judged to be the most
important. It generally requires the user to press the OK key for confirmation, but in the case of a
warning, it disappears after a while. Some alerts reappear when the printer is idle and there is nothing
more important to report.

● Embedded Web Server: The alert displayed in the front panel also appears in the top right corner of the
Embedded Web Server window.

An alert may require you to perform a maintenance operation; see Hardware maintenance on page 11.

The following alerts require a service engineer:

● Service Maintenance Kit 1

● Service Maintenance Kit 2

● Service Maintenance Kit 3
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3 Firmware update

The printer's various functions are controlled by software that resides in the printer, also known as firmware.

From time to time, firmware updates from Hewlett-Packard become available. These updates increase the
printer's functionality and enhance its features.

Firmware updates can be downloaded from HP's Web site (http://www.hp.com/go/graphic-arts/) and
installed in your printer using the printer's Embedded Web Server.

To access the Embedded Web Server from any computer, see Check printer status on page 5.

In the Embedded Web Server, select the Setup tab and then Firmware update.

Follow the on-screen instructions to download the firmware file and store it on your hard disk. Then select
the downloaded file and click Update.

If you experience very slow progress while uploading the firmware file to the printer, the reason could be that
you are using a proxy server. In that case, try bypassing the proxy server and accessing the Embedded Web
Server directly.

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and
select the Bypass proxy server for local addresses check box. Alternatively, for more precise control,
click the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy
server is not used.

● In Firefox 3.0 for Windows, go to Tools > Options > Network > Connection > Settings, and select the
Direct connection to the Internet check box. Alternatively, when the Manual proxy configuration
check box is selected, add the printer's IP address to the list of exceptions, for which the proxy server is
not used.

● In Firefox 2.0 for Linux, go to Edit > Preferences > Network > Connection > Settings, and select the
Direct connection to the Internet check box. Alternatively, when the Manual proxy configuration
check box is selected, add the printer's IP address to the list of exceptions, for which the proxy server is
not used.
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4 Hardware maintenance

For the tasks in this chapter, you may need the User Maintenance Kit that was provided with your printer.

Ink system tips
For best results, always follow these guidelines:

● Follow the instructions on the front panel during installation.

● Allow the printer and the printhead cleaning cartridge to clean the printheads automatically.

● Avoid unnecessary removal of the ink cartridges and printheads.

● The ink cartridges should never be removed while the printer is printing. They should be removed only
when the printer is ready for you to replace them. The front panel guides you through the replacement
procedure.

● Make sure that you comply with all applicable laws and regulations when disposing of ink system
consumables.

NOTE: Shake the ink cartridges and printheads vigorously before installing them.

Align the printheads
The printer performs printhead alignment whenever printheads are replaced. If no substrate is loaded when
a printhead is replaced, the printer will perform the alignment the next time you load substrate.

You may also be recommended to align the printheads to solve a print-quality problem.

Automatic alignment
First make sure that you have a roll of opaque, white substrate loaded in the printer. Colored substrates,
glossy canvas, and transparent materials such as translucent bond, clear film, tracing substrate, and vellum
are not suitable for automatic printhead alignment; for these substrates, you should align the printheads
manually (see Manual alignment on page 12).

To request printhead alignment from the front panel (if the alignment is not performed automatically), select
the  icon, then select Image quality maintenance > Align printheads > Auto PH alignment.

To request printhead alignment from the Embedded Web Server, select the Setup tab, then select Printhead
alignment > Automatic printhead alignment > Print.

The process takes about 10 minutes and starts immediately, unless an image is currently being printed. If a
print job is in process, the alignment will be done as soon as the current print job is finished.
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Manual alignment
To request a manual printhead alignment from the front panel, select the  icon, then select Image quality
maintenance > Align printheads > Manual PH alignment > Print alignment pattern.

To request manual printhead alignment from the Embedded Web Server, select the Setup tab, then select
Printhead alignment > Manual printhead alignment > Print.

The printer prints 17 rows labelled from A to Q. Inspect the print and write down the number of the
straightest line in each row (for example, A:9).

When you have done this, enter the correction values into the front panel or the Embedded Web Server.

To enter the correction values in the front panel, select the  icon, then select Image quality maintenance
> Align printheads > Manual PH alignment > Enter correction values. Enter each value into the window
labelled with the same letter as the corresponding pattern.

To enter the correction values in the Embedded Web Server, select the Setup tab, then select Printhead
alignment > Manual printhead alignment, and enter each value into the window labelled with the same
letter as the corresponding pattern.

Check substrate porosity
To check the porosity of your substrate, proceed as follows.

1. If the printer has any substrate loaded, unload it.

2. Cut a piece of self-adhesive vinyl white gloss 15 × 50 mm (0.6 × 2 in) in size.

3. Stick it to the platen as shown.

4. Load the substrate that you want to check.

5. Open your RIP software.
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6. Download the test file from inside the printer: http://printerIP/hp/device/webAccess/images/
Ink_trespassing_check.pdf, where printerIP is the IP address of your printer.

7. Print the test file using the number of passes and media profile that you intend to use in future with this
substrate (or a similar profile in terms of ink limit).

8. Unload the substrate.

9. Remove the strip of self-adhesive vinyl from the platen.

10. Compare the optical density (darkness) of the strip with the gray rectangle below.

● If the strip is completely white (has no ink on it), the tested substrate is non-porous and can be
used for printing as described in the User's guide.

● If the strip is lighter than the gray rectangle above, the tested substrate can be used for printing,
but the platen should be cleaned immediately after each printing session (see Clean the platen
on page 17).

● If the strip is darker than the gray rectangle above, the tested substrate is too porous, and is not
supported for use with your printer.

Clean the electrical connections on a printhead
It is possible that the printer will not recognize a printhead after it has been installed. This can happen when
ink builds up on the electrical connections between the printhead and the printhead carriage. Under these
circumstances, HP recommends that you clean the electrical connections on the printhead. However, routine
cleaning of the connections when no problems are apparent is not recommended.

A carriage interconnect wiper is included with your printer in the User Maintenance Kit.
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Use this to clean the electrical interconnects on both the printhead carriage and the printhead if the Reseat
or Replace message persists next to the printhead on the front-panel display.

1. Remove a new pre-moistened replacement sponge from its pouch.

A supply of sponges is included in the box with the wiper. If all sponges have been used, more can be
obtained by calling your service representative.

2. Open the carriage interconnect wiper.

3. Load the sponge by positioning the sponge on the face of the carriage interconnect wiper with the
shorter tab in the locating slot.

4. Close the carriage interconnect wiper, trapping the sponge in place.

5. Open the printhead carriage latch and extract the printhead that is causing the problem, as indicated on
the front panel. See Replace a printhead on page 30.
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6. Insert the carriage interconnect wiper into the printhead slot at the back. Wipe the electrical contacts by
inserting the tool between the electrical connections at the back of the slot and the steel spring, with
the sponge facing away from you and towards the electrical contacts. Try to avoid picking up any ink
deposit that may have accumulated on the bottom surface of the slot.

CAUTION: If the carriage remains in the central part of the printer for more than 7 minutes, it
attempts to return to its home position to the right.

7. Rub the sponge against the contacts with a light force along the entire depth of the flex connector,
inserting the wiper as far as allowed by the mechanical stop on the tool.

8. Take special care to clean all contacts thoroughly, including the ones at the lowest point of the
connector.

9. Using the same sponge, clean the lower strip of electrical contacts on the printhead (unless the
printhead is new). Avoid touching the upper set of electrical contacts.

CAUTION: Do not touch the surface of the printhead that contains the nozzles, because the nozzles
are easily damaged.
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10. After waiting a few moments to allow both connectors to dry, replace the printhead into the printhead
carriage. See Replace a printhead on page 30.

11. After completing the cleaning process, open the carriage interconnect wiper by pulling on the sponge
tab.

12. Remove the soiled sponge from the carriage interconnect wiper.

13. Dispose of the soiled sponge in a safe place to prevent the transfer of ink onto hands and clothing.

If the front panel continues to show the Reseat or Replace message, replace the printhead or call your
service representative.

Clean the exterior of the printer
Use a damp sponge or a soft cloth and a mild household cleaner such as non-abrasive liquid soap to clean the
outside of the printer and all other parts of the printer that you regularly touch as part of normal operation
(for example, ink cartridge drawer handles).

There may be some dampness from condensation under the fans of the curing module, which should be
wiped with a dry cloth.

WARNING! To avoid an electric shock, make sure that the printer is turned OFF and unplugged before you
clean it. Do not let water get inside the printer.

CAUTION: Do not use abrasive cleaners on the printer.
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Clean the platen
You should clean your printer's platen every few months, or when necessary.

NOTE: If you print on wide substrate after having printed on narrower substrate, you may find that the left
side of the platen has become dirty. If this contaminated section of the platen is not cleaned, it could leave
marks on the back of the substrate.

CAUTION: Be careful not to damage the substrate-advance sensor when cleaning the platen. The sensor is
the very small rectangular window (less than 1 cm²) found close to the third pinchwheel from the right. See
Clean the substrate-advance sensor window on page 19.

Follow these instructions to clean the platen.

1. Unload all substrate from the printer. See the User's guide.

2. Turn off the printer and wait until it has cooled down, then unlock and open the printer window.

3. Use a clean, absorbent lint-free cloth to thoroughly wipe any wet ink from the cutter grove, cutter ramp
and platen.

4. With a dry brush, remove dry, loosened ink deposits from the cutter groove and cutter ramp. A brush is
available in the User Maintenance Kit.

5. With the same dry brush, remove dry, loosened ink deposits from the platen surface.
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6. Slightly dampen the used cloth with 95% ethanol to wipe the remaining dry ink deposits from the
platen.

NOTE: 95% ethanol is not provided in the User Maintenance Kit.

CAUTION: Ethanol is highly flammable. Observe the manufacturer’s safety precautions.

CAUTION: Do not use commercial cleaners or abrasive cleaners. Do not wet the platen directly,
because you will leave too much moisture behind, which could damage the substrate advance sensor.

7. Use the damp cloth to remove remaining dry ink deposits from the cutter ramp.

8. Use a dry cloth to clean the exposed part of the wheels. Ideally, you should clean the entire
circumference of these wheels.

9. Remove the 95% ethanol and the cloth from the vicinity of the printer.

10. Wait 3 or 4 minutes to let the ethanol evaporate, before turning on the printer and reloading the
substrate.

11. With a 1 mm diameter pin ensure that the vacuum holes are not obstructed, especially the holes that
are covered by the most-used substrate sizes.

Clean after porous substrates
If you print on a porous substrate (through which ink can pass), you should clean the platen immediately
after each printing session. Do not, for instance, leave the printer overnight or load a new roll without
cleaning the platen first.
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When printing on a textile or thin substrate, you may find condensation in the input area of the printer. You
are recommended to wipe it away with a dry cloth, at least before loading a new roll.

Clean (recover) the printheads
To clean the printheads (which often enables them to recover from problems), go to the printer's front panel
and select the  icon, then select Image quality maintenance > Clean printheads. Specify which printheads
you would like to clean. You can clean all of the printheads or only some of them. Select from the following
options.

● Print test plot

● Clean all

● Clean LC-C

● Clean Y-MK

● Clean LM-M

Cleaning all printheads takes about 5 minutes. Cleaning any two printheads takes about 3 minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

Clean the substrate-advance sensor window
The substrate-advance sensor is the very small rectangular window (less than 1 square centimeter in size)
close to the third pinchwheel from the right.

HP recommends that you clean the substrate-advance sensor window whenever you clean the print platen
and if you are experiencing print quality issues.

1. Unload the substrate by using the front panel procedure. See the User's guide.

2. Turn off the printer and wait until it has cooled down.
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3. Wipe the sensor with one of the cotton swabs provided in the User Maintenance Kit, slightly dampened
with 95% ethanol, to remove dried ink.

NOTE: 95% ethanol is not provided in the User Maintenance Kit.

If the sensor window is heavily coated with dried ink, you may need to apply some pressure while
wiping, helping the cotton to absorb the ink. Continue cleaning with fresh swabs until the cotton stays
clean and the sensor window looks clean. When reflecting ambient light, a clean sensor shows a blue-
colored reflection that should extend uniformly across its whole surface. You can see this reflection by
moving closer and slightly changing your angle of view.

4. Remove the 95% ethanol and the cotton swabs from the vicinity of the printer.

5. Wait three or four minutes to let the ethanol evaporate, before turning on the printer and reloading the
substrate.

Clean and lubricate the carriage rail
NOTE: Under some workflows, or/and site conditions such as in warm ambient temperature, which are
above the printer's operation specification (above 30ºC(86ºF)), or if there is significant ambient dust; the
lubrication of the slider rods can be reduced or affected, which can in turn affect the performance of the
printer.

NOTE: A visual explanation of the procedure to clean and lubricate the carriage rail can be found here:
http://www.hp.com/go/L26500/videos

1. To gain access to the carriage, go to the front panel and select the  icon, then select Carriage rail
lubrication.

2. Unlock and open the window.
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3. Clean the carriage rail using a lint-free cloth dampened with 95% ethanol. Take care to clean the whole
rail, including the part under the left cover.

NOTE: 95% ethanol is not provided in the Maintenance Kit.

CAUTION: Ethanol is highly flammable. Observe the manufacturer’s safety precautions.

CAUTION: Do not use commercial cleaners or abrasive cleaners.

CAUTION: While cleaning, be careful not to damage the metal strip located on top of the rail.

4. Wait until the rail is dry, then close the window. The carriage moves to the center of the printer so that
you can reach the part of the rail under the right cover.

5. Unlock and open the printer window.

6. Clean the carriage rail area under the right cover as described in step 3.

7. Take the bottle of oil from the Maintenance Kit that is supplied with your printer (a replacement kit can
be ordered if necessary).
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8. Deposit a very thin zig-zag trickle of oil along the rail on both sides of the carriage. There is a video
showing the process here: http://www.hp.com/go/L26500/videos

NOTE: While lubricating, be careful not to drop oil on the metal strip located on top of the rail.

9. Clean the substrate jam reflector using a lint-free cloth dampened with distilled water. If you find dried
ink that you cannot remove, try using a lint-free cloth dampened with 95% ethanol.

10. Press OK at the front panel.

11. Close and lock the window.

12. The Carriage Assembly moves along the rail to distribute the oil along the rail.

13. The Front Panel prompts for confirmation that the lubrication processes has been done. Press OK to
confirm.

Maintain the ink cartridges
During the normal lifetime of a cartridge, no specific maintenance is required. You should replace a cartridge
when it has reached its expiration date. See the ink cartridge information on the front panel for the expiration
date.

Move or store the printer
If you need to move your printer or store it for an extended period of time, prepare it correctly to avoid
possible damage.

1. Do not remove the ink cartridges, printheads or printhead cleaning cartridge.

2. Make sure that no substrate is loaded.

3. Make sure that the printhead carriage is located in the service station (at the right end of the printer).
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4. Make sure that the Ready message appears on the front panel.

5. Turn off the power by using the Power button on the front panel.

6. Also switch off the power switch at the rear of the printer.

7. Disconnect the two power cables and any cables that connect the printer to a network, a computer, or a
scanner.

8. If you have a take-up reel installed, remove the take-up reel sensor and cable-housing unit from the
foot of the printer stand. When reinstalling the housing unit, make sure that the wheel on the foot of
the printer stand is pointing forward.

9. If you intend to turn the printer upside down or on its side, first remove the waste management system
(see Replace the ink maintenance kit on page 27 and Replace the printhead cleaning kit on page 35).

10. For correct environmental storage conditions, see the specifications in the User's guide.

NOTE: If the printer or ink cartridges are moved from a cold location to a warm and humid location, water
from the atmosphere can condensate on the printer parts and cartridges and can result in ink leaks and
printer errors. In this case, HP recommends that you wait at least 3 hours before turning on the printer or
installing the ink cartridges, to allow the condensate to evaporate.

Replace an ink cartridge
Ink cartridges should be replaced for the following two reasons:

● The ink cartridge is very low and you want to replace it with a full cartridge for unattended printing. You
can use the remaining ink in the first cartridge at a more convenient time.

● The ink cartridge is empty or faulty, and you must replace it to continue printing.

CAUTION: The procedure to remove an ink cartridge must be initiated from the front panel. Do not remove
an ink cartridge until the front panel prompts you. If you remove an ink cartridge incorrectly, the printer may
subsequently reject that cartridge.

CAUTION: Remove an ink cartridge only if you are ready to insert another one.

CAUTION: Avoid touching pins, leads and circuitry when handling ink cartridges because these elements are
sensitive to electrostatic discharge, which can reduce the life expectancy of the device.

WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to prevent the
printer from moving.

Remove an ink cartridge

1. On the printer's front panel, select the  icon, then select Replace ink cartridges.
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2. Grip the blue tab in front of the cartridge that you want to remove.

3. Pull the blue tab down and then pull it outwards, towards you.

4. The cartridge comes out, in its drawer.
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5. Lift the cartridge out of its drawer.

NOTE: Avoid touching the end of the cartridge that is inserted into the printer, because the connection
might be coated with ink.

NOTE: If necessary, store a partially-used ink cartridge in the same position as if it were inserted in
the printer. Avoid using a partially-used cartridge that has been stored on its end.

6. The front-panel display identifies the missing ink cartridge.

Insert an ink cartridge

1. Pick up the new ink cartridge and find the label that identifies the ink color. Hold the ink cartridge so
that you can see the label at the top of the side that is facing you.

2. Check that the colored label above the empty slot in the printer matches the color of the label on the
cartridge.

3. Shake the cartridge vigorously for about 15 seconds.

4. Insert the ink cartridge into the cartridge drawer.
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5. Slide the drawer and cartridge into the slot until they lock into position.

6. The front-panel display confirms that all cartridges have been correctly inserted.

Refilled and non-HP ink cartridges
HP recommends that you replace an empty cartridge with a new HP cartridge.

The use of refilled or non-HP ink cartridges has several disadvantages.

● If printer failure or damage is attributable to the use of a non-HP or refilled ink cartridge, HP will charge
its standard time and materials charges to service the printer for the particular failure or damage.

● If failure or damage to printheads, ink cartridges, or other ink supplies is attributable to the use of non-
HP, expired or refilled ink cartridge, HP is not responsible for the cost of replacement.

● Print quality may be impaired.

● The printer will be unable to estimate the ink level in the cartridge, and will report it as empty.

If you decide to use refilled or non-HP ink cartridges, you will need to follow these instructions to make the
printer use a cartridge that it believes to be empty.

CAUTION: Running completely out of ink can damage the printheads. Damage attributable to printing with
empty ink cartridges is not covered under warranty. Forcing the printer to accept empty cartridges will empty
the ink delivery system as well. Once emptied, ink must be used to refill the system and reprime the
printhead when a new ink cartridge is installed.

1. Install the cartridge in the printer (see Replace an ink cartridge on page 23).

2. The front panel will complain that the cartridge is empty, and the cartridge removal process will start.
Press the Cancel key to stop this automatic process.

3. At the front panel, select the  icon.

4. Highlight Replace ink cartridges, but do not select it.

5. Press the Cancel key and the Up key at the same time, and hold them down for at least two seconds.

6. The front panel will display a series of warning messages. In response to each message, press the
Cancel key to cancel the process, or the Select key to confirm that you wish to continue.
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When you have pressed Select in response to all warning messages, the front panel will give the usual ink
cartridge status display, but the refilled or non-HP cartridge will be shown as empty with a warning sign.

Replace the ink maintenance kit
The ink maintenance kit contains the ink funnel, the ink tube assembly and the ink filter. The front panel
prompts you when these components need to be replaced.

NOTE: When you have removed the ink tube assembly, you cannot reuse it: you must install a new
assembly.

1. Open the ink maintenance kit and remove the spare ink tube cap, which will be used to cover the end of
the old ink tube.

2. On the printer's front panel, select the  icon, then select Replace ink mainten. kit.

3. Pull the bottom of the ink tube assembly out of the printhead cleaning container.

4. Cover the end of the old ink tube with the spare cap from the ink maintenance kit, to prevent ink from
falling out of the tube.

5. Unlock and open the window.
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6. Locate the ink funnel.

7. Pull the slider with one finger while removing the ink funnel with the other hand.

NOTE: You are recommended to wear gloves.

8. Remove the ink tube assembly support and the ink tube assembly.

9. Insert the new ink tube assembly.
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10. Pull the slider with one finger while inserting the new ink funnel with the other hand.

11. Press the ink funnel into place.

12. Remove the cap from the bottom of the ink tube assembly.

13. Insert the bottom of the ink tube assembly into the printhead cleaning container.
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14. Open the ink filter cover.

15. Remove the old ink filter and insert a new one.

16. Close the ink filter cover.

17. Close and lock the window.

Replace a printhead
Remove a printhead

1. On the printer's front panel, select the  icon, then select Replace printheads.

2. The carriage moves to the removal position.

CAUTION: If the carriage remains in the removal position for more than 3 minutes without inserting or
removing any printheads, it will attempt to return back to its home position to the right.
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3. When the carriage has stopped moving, the front panel prompts you to open the printer window. Unlock
and open the window.

4. Locate the carriage on the right side of the printer.

CAUTION: Avoid touching the printer's drying enclosure, which may be hot.

5. Pull up and release the latch on top of the carriage.

6. Lift up the cover. This provides access to the printheads.
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7. To remove a printhead, lift up the blue handle.

8. Using the blue handle, gently disengage the printhead.

9. Gently pull the blue handle upward until the printhead is released from the carriage.

CAUTION: Do not pull abruptly. That action can damage the printhead.

10. The front-panel display identifies the missing printhead.

Insert a printhead

1. If the printhead is new, shake it vigorously before removing the protective caps. Hold the printhead
upright (with the protective caps facing down) and shake the printhead vigorously in a smooth up and
down motion for about 15 seconds.

NOTE: Be careful not to strike the printhead against anything while shaking it, because this could
cause damage.
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2. Remove the orange protective caps by pulling them down.

3. The printhead is designed to prevent you from accidentally inserting it into the wrong slot. Check that
the colored label on the printhead matches the colored label of the carriage slot into which the
printhead is to be inserted.

4. Insert the new printhead into its correct slot in the carriage.

CAUTION: Insert the printhead slowly and vertically, straight down. It can be damaged if you insert it
too quickly, or at an angle, or if you rotate it as you insert it.

5. Push down as indicated by the arrow.

CAUTION: You might feel some resistance when installing the new printhead, so you need to press it
down firmly but smoothly. You should hear a beep and see confirmation on the front-panel display that
the printhead has been inserted.
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6. Insert all of the other printheads that need to be installed, and close the carriage cover.

7. Make sure that the end of the latch catches the wire loop on the near side of the carriage.

8. Lower the latch to rest on the carriage cover.

When all of the printheads have been inserted correctly and the printer has accepted them, the printer
beeps.

NOTE: If the printer does not beep when you insert the printhead and the Replace message appears
on the front-panel display, you might need to reinsert the printhead.

9. Close and lock the printer window.

10. The front-panel display confirms that all of the printheads are correctly inserted. The printer starts
checking and preparing the printheads. The default routine process, when all printheads are changed,
takes up to 18 minutes. If the printer identifies a problem when preparing the printheads, the process
takes longer, up to 30 minutes. For a single printhead insertion, the time varies between 10 and 20
minutes. After all printheads are checked and prepared, the printhead realignment procedure runs
automatically if substrate is loaded.
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Replace the printhead cleaning kit
The printhead cleaning kit contains the printhead cleaning cartridge, the ink funnel and the ink filter.

When the front panel prompts you to replace the printhead cleaning kit, you should replace first the
printhead cleaning cartridge, then the ink funnel, then the printhead cleaning container and ink filter.

NOTE: The printhead cleaning container is not contained in the kit, but should be replaced at the same time.
Therefore, make sure that you have a new printhead cleaning container ready, as well as a new printhead
cleaning kit.

TIP: If you want to remove and inspect the printhead cleaning cartridge at any time, you can start the
following procedure. If you put the old printhead cleaning cartridge back into the printer after inspecting it,
the procedure ends at that point.

1. On the printer's front panel, select the  icon, then select Replace PH cleaning kit.

2. The printhead cleaning cartridge is located in a slot underneath the front panel, at the front of the
printer. Open the door.

Follow these precautions when removing a printhead cleaning cartridge:

● Be careful not to get ink on your hands. Ink may be on, around and inside the replaced printhead
cleaning cartridge.

● Always handle and store the replaced printhead cleaning cartridge upright to avoid spilling any
ink.

WARNING! Make sure that the printer wheels are locked (the brake lever is pressed down) to prevent
the printer from moving.
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3. The printhead cleaning cartridge has a handle on the front. To remove the cartridge, press inward and
upward as indicated by the arrow, until the cartridge is released.

4. Lift up the printhead cleaning cartridge to remove it from the slot, and slide it out.

5. The plastic bag in which the new printhead cleaning cartridge comes can be used to dispose of the old
printhead cleaning cartridge.

6. Remove the plastic cover from the new printhead cleaning cartridge.

7. Insert the printhead cleaning cartridge into the slot, in the direction indicated by the arrow.
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8. When the printhead cleaning cartridge has been pushed all the way in, press inwards and downwards as
indicated, until it clicks into place.

NOTE: The front panel will not show the new printhead cleaning cartridge until the door is closed.

9. When you have inserted the printhead cleaning cartridge into the printer, close the door.

10. Unlock and open the window.

11. Locate the ink funnel.

12. Pull the slider with one finger while removing the ink funnel with the other hand.

NOTE: You are recommended to wear gloves.
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13. Pull the slider with one finger while inserting the new ink funnel with the other hand.

14. Press the ink funnel into place.

15. Close and lock the window.

16. Open the ink filter cover.
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17. Remove the old ink filter and insert a new one.

18. Close the ink filter cover.

19. Remove the printhead cleaning container.

20. Insert the new printhead cleaning container.

NOTE: Before it can resume printing, the printer needs all the ink cartridges, printheads and printhead
cleaning cartridge to be installed, and the printer window and printhead cleaning cartridge door to be closed.

Service maintenance
During the life of your printer, components that are used constantly can wear out.

To avoid having these components degrade to the point that the printer breaks down, the printer keeps track
of the number of cycles that the printer carriage makes across the axis of the printer, and also monitors the
total quantity of ink used.

The printer uses these numbers to track the need for service maintenance, and displays one of the following
messages on the front panel:

● Service Maintenance Kit 1

● Service Maintenance Kit 2

● Service Maintenance Kit 3

These messages mean that some components are nearing the end of their lives. You can continue printing for
quite some time, depending on your use of the printer. However, HP strongly recommends that you call your
service representative and arrange for a service maintenance visit. The service engineer can then replace the
worn parts on-site, which will prolong the life of the printer.

The benefits of arranging a service engineer's visit when these messages appear on the front panel are two-
fold:

● The printer components can be replaced at a time that is convenient for you, and so will not disturb your
daily workflow.

● During a service maintenance visit, the service engineer replaces several parts at once. This eliminates
the need for repeat visits.
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5 Substrate settings

Download media presets
Each supported substrate has its own characteristics. The printer changes the way it prints on each different
substrate. The RIP requires a description of the requirements of each substrate. This description is called the
“media preset”.

The media preset contains the ICC color profile, which describes the color characteristics of the substrate. It
also contains information about other characteristics (RIP and printer settings) and requirements of the
substrate that are not directly related to color. Media presets for your printer are installed in the RIP.

The RIP contains media presets for only the most commonly used substrates. If you buy a substrate for which
your RIP has no preset, you can obtain a preset for a new substrate in the following ways:

● Try to download the media preset from the substrate manufacturer's Web site.

● If it is not there, try to download it from the RIP company's Web site.

● If it is not there, check availability using the HP Media Finder search application located at
http://www.hp.com/go/latexmediafinder/

● If you cannot find it anywhere, create a new media preset in the RIP. See Add a new substrate
on page 41.

● Further information can be found at and http://www.hp.com/go/L26100/solutions/.

Add a new substrate
This section is provided in case you decide to make your own media preset. Normally there is no need to do
this if you can find ready-made presets for all the substrates that you use.
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Summary

Select printer settings and color profile
The correct printer settings for your substrate may be available from your RIP vendor or substrate vendor. If
not, you can start by copying printer settings from a similar substrate of the same family. For more
information on substrate families, see the User's guide.

If you cannot find a similar substrate for some reason, here are some recommended default settings for each
substrate family.
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Substrate family Drying
temp.

Curing
temp.

Heating
airflow

Auto-
tracking
(OMAS)

Cutter Substrate
-advance

compensa
tion

Input
tension

Vacuum

Self-adhesive 55 110 30 Yes Yes 0 15 25

Banner 50 110 45 Yes No 0 15 5

Textile 55 100 45 Yes No 0 15 20

Film 55 95 30 Yes Yes 0 15 25

Synthetic paper 50 80 30 Yes Yes 0 15 40

Paper-aqueous 45 70 30 Yes Yes 0 15 20

Paper-solvent 50 90 30 Yes Yes 0 15 25

Low-temperature
substrate

50 80 30 Yes Yes 0 15 40

Mesh 50 95 30 Yes Yes 0 15 30

The various settings mentioned above are described below.

Setting Description If too low If too high

Passes The number of passes specifies
how many times the printheads
will print over the same area of
the substrate.

The amount of ink fired per time
unit is larger and ink has less time
to dry on the substrate. This may
create coalescence and banding.
The boundaries between passes
may be more visible. However,
printing speed is relatively high.

Colors are vivid, print quality is
high. However, printing speed is
relatively low. A lower curing
temperature is needed, otherwise
the substrate may be deformed.

Drying temp.
The heat applied in the printing
zone removes water and fixes the
image to the substrate.

Print-quality defects such as
banding, bleeding and coalescence
may occur.

Thermal marks may be seen on
the substrate; they may appear as
vertical bands in some colors. The
substrate may wrinkle on the
platen, causing vertical banding,
ink smears or substrate jams.

Curing temp. Curing is needed to coalesce the
latex, creating a polymeric film
which acts as a protective layer,
while at the same time removing
the remaining co-solvents from
the print. Curing is vital to ensure
the durability of the printed
images.

The print may emerge not fully
polymerized, so that the ink
smears when rubbed. The print
may appear wet, after printing or
later. You may need to increase
the number of passes to achieve
adequate curing.

The substrate may wrinkle under
the curing module, causing
defects such as blisters or liner
detachment. The substrate
wrinkles may also cause vertical
banding or ink smears at the
beginning of the following plot.

Heating airflow Airflow helps to remove the
evaporated water from the print
zone and thus allows more
efficient drying.

In general, use the substrate family default value.

Substrate advance
compensation

Your printer was calibrated at the
factory to ensure that it advances
the substrate accurately when
using supported substrates in
normal environmental conditions.
However, you may find it useful to
adjust the substrate advance
when printing in an unusual but
stable temperature or humidity
level, or if the substrate-advance
sensor is not working.

You may see horizontal banding or
grain.

You may see horizontal banding or
grain.
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Setting Description If too low If too high

Input tension Tension is applied to the substrate
from the input spindle. It needs to
be constant over the full width of
the substrate, thus substrate load
is a critical operation.

The substrate skews and may
become increasingly wrinkled in
the printing zone. Also, substrate
advance may be irregular,
resulting in horizontal banding.

The substrate may be
permanently deformed or
damaged. Substrate advance
problems may appear in extreme
cases.

Vacuum The vacuum applied to the
substrate at the printing zone
helps to hold the substrate down
on the print platen, keeping the
distance to the printheads
constant.

The substrate may lift up off the
platen and touch the printheads.
This can smear the printed image,
cause vertical banding, cause a
substrate jam or even damage the
printheads.

For sticky substrates, friction
could be too high and substrate
advance irregular, resulting in
horizontal banding or irregular
grainy patches.

Bidirectional Specifies whether printheads print
in both directions, when moving
from left to right and from right to
left.

If Bidirectional is selected, the
amount of ink fired per unit of
time is larger, and therefore print
quality defects such as
coalescence and banding may
occur, especially at the sides of
the plot. However, printing speed
is high.

If Bidirectional is unchecked then
the printing is unidirectional and
the speed is relatively low.

TIP: You are recommended to
keep Bidirectional selected in all
cases, increasing the number of
passes if necessary to avoid
coalescence and banding.

High ink level The maximum quantity of ink will
be laid on the substrate (the High
ink level option available only
when the number of passes is 10
or more). The ink quantity may be
reduced by the RIP color profile.

If not selected, colors may look
washed-out.

If selected, there can be excess of
ink and some problems related to
poor drying and curing.

TIP: Select High ink level for
backlit and some textile
applications, or if you want high
color saturation.

Cutter The printer's built-in cutter can cut
the substrate automatically
between each print.

Disable the cutter in the following cases:

● You want to increase the speed of printing.

● You want to use the take-up reel.

● You want to cut the substrate manually.

● The leading edge of the substrate tends to curl and cause
substrate jams.

In some cases, the cutter is automatically disabled.

Auto tracking (OMAS) The substrate-advance sensor
(also known as the Optical Media
Advance Sensor, OMAS) is located
under the print platen; it can track
the substrate advance
automatically.

Disable the sensor in the following cases:

● The substrate allows ink to pass through to the platen. Clean the
sensor after using this substrate.

● You are instructed to do so by the front panel, because the sensor
is dirty or unable to track this particular substrate.

Load the substrate and print the diagnostic plot
1. Load the substrate in the normal way, paying particular attention to the following points.
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● The stop at the right-hand end of the spindle has two possible positions on the spindle. Always use
the leftmost position if possible. Use the rightmost position only if the substrate roll requires the
full width of the spindle.

● Turn off the substrate-advance sensor (OMAS) in the RIP if the substrate is transparent or dark, or
if the printer recommends you to do so.

● Align the printheads.

2. Open the HP diagnostic chart in the RIP. The chart is stored in your printer, at http://ip-addr/hp/device/
webAccess/images/new.tif, where ip-addr is the IP address of your printer. You can also find it at
http://www.hp.com/go/L26500/manuals/ and http://www.hp.com/go/L26100/manuals/.

3. Select a suitable number of passes for the substrate family. See Select the number of passes
on page 47.

4. Print the plot.

Change settings while printing
You can use the front panel to change the following settings while printing.

● To change temperature and vacuum settings while printing: select the  icon, then Image quality
maintenance > Adjust printing params, and choose the setting that you want to adjust. You can use
the arrow keys to adjust the curing temperature, the drying temperature or the vacuum pressure. The
changes that you make take effect immediately, but they are not saved: the next job will use the
settings in the media profile as usual.

● To change substrate advance calibration while printing (in case of banding): select the  icon, then
Image quality maintenance > Substrate advance calib > Adjust substrate advance. You can use the
arrow keys to adjust the substrate advance. The changes that you make take effect immediately, but
they are not saved for the next job. See also Substrate advance adjustment on the fly on page 56.

● To enable or disable extra printhead cleaning while printing: select the  icon, then Image quality
maintenance > Enable extra PH cleaning or Disable extra PH cleaning. In this case, the change of
setting is saved for subsequent jobs.

NOTE: Extra printhead cleaning shortens the life of the printhead cleaning cartridge.

Advanced settings
Here are some more advanced settings, which you are not recommended to change, unless you have
problems that you cannot resolve any other way.

The drying and curing temperatures used by the printer are determined by adding the offset to the base
temperature. The base temperatures shown in the table are the default values for each substrate family, but
may be changed by the printer depending on the printer settings in use. You cannot change the base
temperatures yourself, but you can change the offsets. The base warm-up drying temperature is determined
by the RIP.

Your RIP may have an option to return all settings to their default values.

Substrate
family

Warm-up
drying

temperatur
e offset

Warm-up
curing

temperatur
e

Warm-up
curing

temperatur
e offset

Cool-down
drying

temperatur
e

Cool-down
drying

temperatur
e offset

Cool-down
curing

temperatur
e

Cool-down
curing

temperatur
e offset

Minimum
drying
power

Self-
adhesive

10 95 0 80 0 95 0 0.7

Banner 10 95 0 80 0 90 0 0.7
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Substrate
family

Warm-up
drying

temperatur
e offset

Warm-up
curing

temperatur
e

Warm-up
curing

temperatur
e offset

Cool-down
drying

temperatur
e

Cool-down
drying

temperatur
e offset

Cool-down
curing

temperatur
e

Cool-down
curing

temperatur
e offset

Minimum
drying
power

Textile 5 85 0 80 0 90 0 0.7

Film 5 85 0 80 0 100 0 0.7

Synthetic
paper

5 80 0 75 0 85 0 0

Paper-
aqueous

5 60 0 75 0 85 0 0

Paper-
solvent

10 75 0 75 0 90 0 0.7

Low-temp. 10 80 0 75 0 85 0 0

Mesh 10 85 0 80 0 85 0 0.7

The various settings mentioned above are described below.

Setting Description If too low If too high

Warm-up drying
temperature

The base temperature that the
substrate in the print zone must
reach before printing starts.

This setting is determined by the RIP. You cannot change it.

Warm-up drying
temperature offset

This offset is added to the base
warm-up drying temperature, and
the total is displayed in the front
panel while the printer is
preparing to print.

Bleeding or coalescence may
appear in the first 200-300 mm of
the print.

A longer time to start printing is
required. Vertical banding or ink
smears may occur.

Warm-up curing
temperature

The base temperature that the
substrate in the curing zone must
reach before printing starts.

This setting is determined by the printer. You cannot change it.

Warm-up curing
temperature offset

This offset is added to the base
warm-up curing temperature, and
the total is displayed in the front
panel while the printer is
preparing to print.

The beginning of the print is not
fully dry, or looks oily.

Substrate degradation (blisters,
adhesive detachment) at the
beginning of the print.

Cool-down drying
temperature

The base temperature at which
the substrate can be under the
drying module without being
damaged. At the end of a job, the
substrate is not stopped until this
temperature is reached.

This setting is determined by the printer. You cannot change it.

Cool-down drying
temperature offset

This offset is added to the base
cool-down drying temperature.

A long time is needed to finish the
print.

The substrate at the beginning of
the next print may be damaged,
because it has stopped moving
under too high a temperature. This
case is uncommon.

Cool-down curing
temperature

The base temperature at which
the substrate can be under the
curing module without being
damaged. At the end of a job, the
substrate is not stopped until this
temperature is reached.

This setting is determined by the printer. You cannot change it.
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Setting Description If too low If too high

Cool-down curing
temperature offset

This offset is added to the base
cool-down curing temperature.

A long time is needed to finish the
print.

The end of the print may be
damaged if the cutter is disabled.

Minimum drying
power

The minimum power applied in the
drying module while printing, so
the substrate does not cool too
much in lightly inked areas.

A heavily inked area that comes
after a lightly inked area will have
bleeding or coalescence defects.

The substrate is damaged in blank
or lightly inked areas of the print,
especially with a high number of
passes.

Temperature profile
Many of the main and advanced substrate settings are related to temperature control, since this is a critical
area for correct printing results with latex inks on a wide variety of substrates. The diagram below
graphically represents the evolution of drying and curing temperatures during the various printing phases.

NOTE: Target temperatures and time are not to scale. For the specific values used for a given substrate
type (family), consult the main and advanced settings tables above.

NOTE: tp time can be modified through the printer’s front panel.

Select the number of passes
Increasing the number of passes will tend to improve the print quality but reduce the speed of printing.

Passes Uni/bidir Self
adhesive

Banner Textile Film Syntheti
c paper

Paper
aqueous

Paper
solvent

Low
temp.

Mesh

4 Bidir No No No No No No No No No

6 Bidir Maybe Start
here

No No No Start
here

Maybe Maybe No

8 Bidir Start
here

Yes No No No Yes Start
here

Start
here

Start
here
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Passes Uni/bidir Self
adhesive

Banner Textile Film Syntheti
c paper

Paper
aqueous

Paper
solvent

Low
temp.

Mesh

10 Bidir Yes Yes No No No Yes Yes Yes Yes

12 Bidir Yes Yes Start
here

Maybe Maybe Yes Yes Yes Yes

16 Bidir Yes Yes Yes Start
here

Start
here

Yes Yes Yes Yes

18* Bidir Yes Yes Yes Yes Yes Yes Yes Yes Yes

20 to 32 Bidir Yes Yes Yes Yes Yes Yes Yes Yes Yes

* Unlike other printmodes, the 18-pass printmode has 1200 dpi x 1200 dpi input data resolution at 1 bpp (1
bit per pixel). Therefore, to generate a 18-pass media preset you should start either from an existing 18-pass
preset or from scratch. In the same way, do not clone an 18-pass media preset to generate a preset with a
print mode other than 18-pass.

Key

● Bidir: bidirectional

● No: not recommended

● Maybe: may be worth trying for extra speed

● Start here, Yes: recommended

NOTE: More specific settings for many substrates from different vendors are available in the HP Media
Finder at http://www.hp.com/go/latexmediafinder/.

Check the quantity of ink on the substrate
Check that the ink quantities in your media preset are adequate. Look at the color patches in the HP
diagnostic chart and check that the patches have the correct amount of ink using the guidelines below:

1. Too much ink: There are several possible symptoms of this problem.

● The last two or three scales of the chart look the same.
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● Vertical bands.

● Horizontal bands.

● Coalescence, grain (can be caused by an excess of light ink).

Try reducing the amount of ink in your RIP software, then reprint the chart and check again.

You may have chosen a media preset that uses more ink than your substrate allows. Consult your RIP
documentation to make sure you’re applying the right media preset, and to find out how to lower the
total ink limits of the media preset. For a quick solution, you could change to a different media preset
that uses less ink: for example, paper-aqueous presets use less ink than self-adhesive presets.

2. Correct amount of ink: The top level of each patch shows a smooth gradient, there are no visible
defects and increasing amounts of ink result in increasing color density.
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3. Too little ink: The whole chart looks washed out.

Try increasing the amount of ink in your RIP software, then reprint the chart and check again.

You may have chosen a media preset that uses less ink than your substrate allows. Consult your RIP
documentation to make sure you’re applying the right media preset, and to find out how to increase the
total ink limits of the media preset. For a quick solution, you could change to a different media preset
that uses more ink: for example, self-adhesive presets use more ink than paper-aqueous presets.

NOTE: Backlit and some textile substrates usually need to be used with the “High Ink Limit” option enabled
in the RIP.
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Faster printing
The obvious way to increase speed is to reduce the number of print passes, although this will tend to reduce
print quality. Bear in mind the following considerations.

● With fewer than 10 passes, you may see an increase in grain.

● With fewer than 8 passes, the printer is more sensitive to substrate advance problems.

● With fewer than 8 passes, you may need to reduce the ink quantity to improve print quality.

● If you want to use the high ink level option, you must use at least 10 passes.

● As you reduce the number of passes, the best curing temperature may be more difficult to find, and may
be more sensitive to the ambient temperature and humidity.

Here are some other suggestions for increasing the speed of printing.

● Concatenating prints saves time, because one can be sent while another is being printed.

● Disable the cutter: select the  icon, then select Substrate handling options > Enable cutter > Off.
With most substrates, this saves some time at the end of the printing process.

● Increase the cool-down curing temperatures. This also saves some time at the end of the printing
process, but may cause slight substrate deformation, depending on the substrate.

See also The printer seems slow on page 76.

Color calibration
The purpose of color calibration is to produce consistent colors with the specific printheads, inks and
substrate that you are using, and in your particular environmental conditions. After color calibration, you can
expect to get identical prints from your printer on different occasions.

Color calibration can be launched from your RIP software; see your RIP documentation for details.

In outline, the process consists of the following steps.

1. A calibration test chart is printed.

2. The HP Embedded Spectrophotometer (or, if you prefer, a different spectrophotometer) scans and
measures the test chart.

3. The RIP uses the measurements to calculate the necessary correction factors for consistent color
printing on that substrate.

Color calibration with the Embedded Spectrophotometer is not recommended for the following substrate
types. It may be possible to calibrate some of these substrates by using an external color measurement
device.

● Non-opaque substrates such as clear film, backlit substrates, and some textiles.

● Substrates with an uneven surface, such as perforated vinyl or punched-window substrates.

● Substrates that suffer deformation from drying and curing, such as paper-based substrates.

● Very elastic substrates, such as some textiles without liner.

Substrates suitable for color calibration include even-surfaced adhesive vinyls (neither punched nor
perforated), PVC banners and some opaque, stiff textiles.
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Some textiles require the take-up reel for successful printing. However, the take-up reel may fail to cope
with the backward movement of the substrate between the printing and scanning phases of color calibration.
To avoid this problem, proceed as follows.

1. Ensure that the take-up reel is enabled.

2. Advance the substrate until the loop-shaper reaches its lowest position.

3. Manually rewind the take-up reel, using the buttons on the take-up reel motor, to collect the substrate
and raise the loop-shaper until it almost touches the take-up reel spindle.

4. Set the take-up reel's wind direction to neutral.

5. Launch color calibration from the RIP.

6. When the color calibration has finished, you can re-enable the take-up reel.

Color profiles
Color calibration provides consistent colors, but consistent colors are not necessarily accurate. For instance,
if your printer prints all colors as black, its colors may be consistent but they are not accurate.

In order to print accurate colors, it is necessary to convert the color values in your files to the color values
that will produce the correct colors from your printer, your inks and your substrate. A color profile is a
description of a printer, ink and substrate combination that contains all the information needed for these
color conversions.

These color conversions are performed by your Raster Image Processor (RIP), not by the printer. For further
information on the use of color profiles, see the documentation for your application software and for your
RIP.

In addition to the color profiles used for printing, you may wish to calibrate and profile your monitor (display
device), so that the colors you see on the screen relate more closely to those that you see on your prints.

Color reproduction tricks
Latex inks are a new technology, and there are some important guidelines when doing color separations
(such as when creating or modifying a new media preset within your RIP) that will help to optimize the printer
output in terms of color gamut, ink usage and print quality. These are as follows:

● To achieve the best dark colors in vinyl gloss and other substrates, use as much black and as little
composite (CMY) as possible when creating the ICC profile.

● Light inks should be avoided as much as possible in high-density colors such as secondaries and
tertiaries (dark red, blue, green, ...).

● Light inks should be restricted to the lowest-density colors, starting the use of dark inks as early as
possible. Typically, a color of more than 50% density should not contain any light inks.

● Light inks should be used at no more than 50% of maximum quantity. An excessive amount of light inks
can create gloss artifacts in vinyl gloss substrates.

Please refer to your RIP documentation for details of how to create or modify media presets.

Presets for HP-branded substrates have been created following the above recommendations in order to
optimize black and dark colors. You can find the HP media preset for your substrate family at
http://www.hp.com/go/latexmediafinder/.
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6 Troubleshoot print-quality issues

General printing advice
Use the following approach when you have any print-quality problem:

● Make sure that the substrate type that you select on the front panel, and in your RIP software, is the
same as the substrate type that is loaded in the printer. Make sure that the substrate type has been
calibrated.

CAUTION: If you have the wrong substrate type selected, you could experience poor print quality and
incorrect colors, and perhaps even damage to the printheads.

● Make that you are using the correct media profile for your substrate, or that you have followed the
correct procedure to generate a new media profile (see Add a new substrate on page 41).

● Make sure that you are using appropriate print-quality settings in your RIP software.

● Make sure that you are using the correct ICC profile for your substrate and print-quality settings.

● Make sure that your environmental conditions (temperature, humidity) are in the recommended range.
See the User's guide.

● Make sure that your ink cartridges have not passed their expiration dates. See Maintain the ink
cartridges on page 22.

● Avoid touching the substrate while printing is in progress.

Use the printhead status plot
The printhead status plot consists of patterns that are designed to highlight printhead-reliability problems. It
helps you to check the performance of the printheads that are currently installed in your printer, and to
determine whether any printhead is experiencing clogging or other problems.

Print the printhead status plot
To print the printhead status plot:

1. Use the same substrate type that you were using when you detected a problem.

2. Check that the selected substrate type is the same as the substrate type that is loaded into the printer.

3. On the printer's front panel, select the  icon, then select Image quality maintenance > Print all test
plots.

Interpret the printhead status plot
The print consists of small dashes, one for each nozzle on each printhead.
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For each individual colored pattern, make sure that most of the dashes are present.

Corrective action
1. Clean any faulty printheads. See Clean the printheads on page 72. Then reprint the printhead status

plot to see whether the problem has been solved.

2. If the problem persists, clean the printheads again, and reprint the printhead status plot to see whether
the problem has been solved.

3. If the problem continues to persist, replace any persistently faulty printheads. See Replace a printhead
on page 30.

What to do if problems persist
If you still experience print-quality problems after applying the advice in this chapter, here are some
additional tips to consider:

● Try selecting a higher print-quality option in your RIP software.

● Check that your printer firmware is up to date. See Firmware update on page 9.

● Check that you have the correct settings in your software program.

● Call your service representative. See When you need help on page 85.

Graininess

If you see this kind of problem:

● Ensure that the vertical correction option is disabled in the RIP and in the front panel. At the front panel,
select the  icon, then select Image quality maintenance > Disable vertical correct. (if this option is
available).

● The printheads may be misaligned. This is likely if you have not aligned the printheads for a long time,
or if there has been a substrate jam. Align the printheads if necessary (see Align the printheads
on page 11). You can check whether it is necessary by using the printhead status plot (see Use the
printhead status plot on page 53).

● If you are printing with eight or more passes, the substrate advance may need adjustment. See Adjust
the substrate advance on page 56.
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● Use a higher number of passes: you will probably see less grain with ten or more passes.

● If graininess is more visible in dark or saturated colors, there may be a problem of ink coalescence. Try
lowering the ink quantity.

If the problem persists, call your service representative. See When you need help on page 85.

Horizontal banding
Try the following remedies if your printed image suffers from added horizontal lines as shown (the color may
vary).

● If bands affect mostly dark or saturated colors, or only area fills near the edges of the substrate, the
cause could be insufficient drying of the ink, or an inaccurate color profile. Try the following
suggestions.

◦ Reduce the ink quantity.

◦ Increase the number of passes.

◦ Modify your media preset as suggested in Color reproduction tricks on page 52.

● If bands affect all colors across the width of the printed image, the cause is probably a substrate
advance problem. Use the front panel to adjust the substrate advance on the fly (see Substrate advance
adjustment on the fly on page 56). If you have dark bands, increase the substrate advance; if you have
light bands, decrease it. When you find the right adjustment, store the value in the RIP for future prints
on the same substrate.

Another cause could be a fiber attached to one of the printheads. Turn off the printer and allow it to
cool down, then remove the printheads one at a time and remove any fibers that you see attached to
them.

● If bands affect only some colors, the cause could be a defective printhead.

◦ Print the printhead status plot (see Use the printhead status plot on page 53). If necessary, clean
the printheads (see Clean (recover) the printheads on page 19).

◦ Clean the printheads again.

◦ Align the printheads (see Align the printheads on page 11). If necessary, align them manually.

◦ Print the printhead status plot again. Identify the printhead with the greatest number of blocked
nozzles, and replace it.

◦ If bands appear and disappear intermittently, go to the front panel and select the  icon, then
Image quality maintenance > Enable extra PH cleaning. Remember to disable this option when
you no longer need it, because it shortens the life of the printhead cleaning kit.

● If bands affect most of the colors, the printheads could be misaligned. This is likely if you have not
aligned the printheads for a long time, or if there has been a substrate jam. Align the printheads if
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necessary (see Align the printheads on page 11). You can check whether it is necessary by using the
printhead status plot (see Use the printhead status plot on page 53).

● If banding occurs mostly in black areas, create a new color profile using pure black and not a mixture of
other colors. See your RIP documentation.

If the problem persists, call your service representative (see the User's guide).

Adjust the substrate advance
The substrate advance sensor measures the advance of the substrate and compensates for irregularities at
every pass of the printheads. However, to fine-tune the quality of your print, you may need to calibrate the
rate at which the substrate advances. The substrate advance determines the placement of dots on the
substrate. If the substrate is not advanced correctly, light or dark bands appear in the printed image and the
grain in the print may increase.

You can modify the substrate advance with the Substrate Advance parameter in the RIP's substrate preset.

1. On the front panel, select the  icon, then select Image quality maintenance > Substrate advance
calibration > Print adjustment plot. The printer prints a substrate-advance adjustment image.

2. The calibration image consists of several columns with a number at the bottom of each one. Locate the
lightest of the columns and enter its number into the RIP's Substrate Advance parameter for the current
substrate preset. The value chosen in this example should be “–6”.

Substrate advance adjustment on the fly

If you are using no more than six passes, you can fine-tune the substrate advance while printing: select the
 icon, then select Image quality maintenance > Substrate advance calibration > Adjust substrate

advance. Select a value of change from –10 mm/m to +10 mm/m (or mils/inch). To correct light banding,
decrease the value. To correct dark banding, increase the value.

If you are using eight passes or more, a wrong advance adjustment will not produce banding but graininess,
which is harder to assess visually. Therefore, in this case you are recommended to use only the adjustment
plot.

When you have chosen a value and pressed OK, the rest of your job will be printed with that value, but it will
be reset to zero at the end of the job. Add the value found to the Substrate Advance value in the RIP preset to
print all future jobs with the new setting.

A simpler and faster way to adjust the substrate advance while the printer is printing is by pressing the Move
Substrate button on the front panel, which then displays the following instructions.
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As you modify the setting, the new setting is applied immediately to the current job by the printer. When you
press OK to save the value, it is saved in the printer to be used throughout the current job.

Vertical banding
There are several different kinds of vertical banding that may be seen.

● Wide vertical bands visible by darkness or graininess, typically seen on vinyl and banner substrates in
medium-density area fills such as grays, violets and greens

◦ Align the printheads. See Align the printheads on page 11.

◦ Try the automatic correction for vertical banding provided by the RIP. Depending on your firmware
version, this option may also be provided by the front panel: select the  icon, then select Image
quality maintenance > Enable vertical correct. (if this option is available).

NOTE: Remember to disable the vertical banding correction when you no longer need it, because
it may increase grain.

● Thin vertical bands visible by darkness, typically seen in the first 150–200 mm of the print on vinyl and
banner glossy substrates in high-density area fills or in backlit applications

◦ Reduce the ink quantity if possible.

◦ Disable the cutter.

◦ Increase the number of passes.

◦ If applicable, tell the RIP to group jobs together, so that printer temperatures remain more stable
between jobs.

◦ Modify your media preset as suggested in Color reproduction tricks on page 52.

● Irregular or isolated vertical bands

◦ Increase the vacuum level in steps of 10 mmH2O. Do not exceed the following limits: 20 mmH2O
for banners, 35 mmH2O for vinyl, and 50 mmH2O for other substrate families.

◦ In backlit applications, increase the number of passes to 20 or more, and change the drying
temperature up and down in steps of 5°C.

◦ If the banding appears only at the beginning of the print, disable the cutter and advance the
substrate manually about 100–150 mm before the first print.

The print is deformed into a curved shape
This may occur as a result of substrate bow deformation. See The substrate has bow deformation
on page 67.
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Misaligned colors

If the colors are misaligned in any direction, the printheads may be misaligned. This is likely if you have not
aligned the printheads for a long time, or if there has been a substrate jam. Align the printheads if necessary
(see Align the printheads on page 11). You can check whether it is necessary by using the printhead status
plot (see Use the printhead status plot on page 53).

Color intensity varies
If some printhead nozzles are in use while others in the same printhead are not, water evaporates slowly
from the ink in the unused nozzles, making the color more intense. Thus, in such cases you may notice
variations in color intensity in areas where the color of the image should be constant.

If you notice such a problem, there are various possible solutions.

● At the front panel, select the  icon, then select Image quality maintenance > Enable color variation
correction. This correction will then remain enabled until you disable it.

● If you notice the variation in intensity near one side of the print, try rotating the image by 180 degrees
before printing. This may solve the problem in some cases, as all the nozzles are refreshed whenever
they enter the service station between passes.

● Use your RIP to add lateral color bars on the side of the plot that is close to the ink supplies. The color
bars are designed to exercise all the printhead nozzles, to prevent the problem from occurring.

NOTE: Not all RIPs provide this option.

● Add lateral color bars to the image, manually, before printing. In this case, you can either use the
standard colors, or decide to include a particular color in which you have noticed the problem. The
recommended width of each color bar is 3 mm.
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Lack of sharpness
If text, lines or solid areas are rough or blurred, the printheads may be misaligned. This is likely if you have
not aligned the printheads for a long time, or if there has been a substrate jam. Align the printheads if
necessary (see Align the printheads on page 11). You can check whether it is necessary by using the
printhead status plot (see Use the printhead status plot on page 53).

Black areas look hazy
If black areas look hazy or not sufficiently black, try these suggestions.

● Increase the number of passes.

● Laminate the print.

● See Color reproduction tricks on page 52.

Ink smears
Ink smears may be seen on the print for the following reasons.

● The substrate is skewed. Do not ignore the warning message that appears during the loading process if
there is significant skew.

● The substrate is not flat in the print zone. Try the following possible solutions.

◦ Increase the vacuum level in steps of 10 mmH2O. Do not exceed the following limits: 20 mmH2O
for banners, 35 mmH2O for vinyl, and 50 mmH2O for other substrate families.

◦ Reduce the curing temperature. You will probably need to increase the number of passes in order
to achieve adequate curing.

◦ Check whether there are fibers on the printheads.

If the problem appears only at the beginning of the print, try the following suggestions.

● Disable the automatic cutter.

● Go to the front panel and select the  icon, then Substrate handling options > Extra bottom margin.
Set the margin to 100 mm. If that is not enough, try 150 or 200 mm. This extra margin will apply only to
jobs that start printing when the printer is idle and when the cutter is disabled.

● Increase the vacuum level in steps of 10 mmH2O. Do not exceed the following limits: 20 mmH2O for
banners, 35 mmH2O for vinyl, and 50 mmH2O for other substrate families.

● Decrease the warm-up drying temperature in steps of 5°C.

● Decrease the warm-up curing temperature in steps of 5°C.

● Increase the number of passes.

● Make sure that the substrate is stored in the same room in which the printer is located.

Subtle stains or uneven appearance
Subtle color differences may be seen on some substrates if they are stored partially covered after printing. In
the period immediately after printing, such substrates should be stored either totally covered or totally
uncovered. It may be advisable to avoid the prolonged contact of two printed faces. This problem tends to
disappear if the substrate is left uncovered for some time.
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Alternatively, some individual rolls of substrate may have a defective coating. The solution in this case is to
use another roll.

The ink smudges when touched, or looks oily
There are various different circumstances in which these symptoms can be seen.

● When there is a big transition from light to dark colors across the length or width of the substrate

Increase the minimum drying power.

NOTE: This solution is specific to this problem, and should not be used in other cases, when it could
cause further problems.

● When the symptoms can be seen only at the start of the first print after the printer has been idle for
some time (especially when the start of the print uses a lot of ink)

Increase the warm-up drying temperature offset and the warm-up curing temperature offset. If
necessary, increase the stable drying and curing temperatures, or slightly reduce the ink limits.

● When the symptoms can be seen only at the left and right sides of the print

Increase the drying and curing temperatures, decrease the overall ink quantity and/or increase the
number of passes.

● When the symptoms can be seen only in certain parts of the print that use a lot of ink

Increase the drying and curing temperatures, decrease the overall ink quantity and/or increase the
number of passes.

● When the symptoms can be seen only in the center of the print

Check that all fans are working correctly.

● After reducing the number of passes

Increase the drying and curing temperatures and/or decrease the overall ink quantity.

● When the oily finish appears minutes or hours after printing

Store the print face-up and uncovered; the effect normally disappears after a while.

NOTE: If you decrease the overall ink quantity, you may notice less color saturation.

The dimensions of the print are wrong
As the substrate is heated during the drying and curing processes, some substrates will shrink (and some
may expand) after the image has been printed. This may be inconvenient if the print has to be framed or if
several prints are to be to be tiled one next to the other.

See The substrate has shrunk or expanded on page 66.

Tiling issues
The most common problems when printing tiles are as follows.

● Color degradation within individual tiles

In many cases, individual tiles are long and contain very large areas of solid colors. This combination
(long areas of saturated solid colors) may lead to a degradation of printhead performance, which can
then cause degradation of the color inside the tile. To solve this problem, go to the front panel and
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select the  icon, then Image quality maintenance > Enable extra PH cleaning. Remember to disable
this option when you no longer need it, because it shortens the life of the printhead cleaning kit.

● Color variation tile to tile

In some cases contiguous tiles with the same background solid color may show differences in color
between the right side of the first tile and the left side of the second tile. This is a common issue of
inkjet printers (both thermal inkjet and piezo inkjet), where there are slight color variations as the swath
advances. Since the biggest color differences are between the left edge and the right edge, the effect
may sometimes be seen when putting two tiles together. This issue can easily be overcome by inverting
alternate tiles, which has the effect of placing the right side of the first plot next to the right side of the
second plot and the left side of the second plot next to the left side of the third, so all contiguous areas
have been printed in the same point of the swath and, hence, have the same color. This is a feature that
all RIPs have available.

● Dimensional variations from tile to tile

Some specific banner substrates may not have uniform dimensional stability when printing very long
tiles. The result is that the length of the tile may be different between the left and the right side (e.g. a 9
meters long tile may be ~1 cm longer on the right side compared to the left side). While this is not
noticeable with individual plots, it affects the alignment between panels in tiling applications. Substrate
types that show this behavior tend to show it constantly along the roll. So, when present, this issue can
easily be overcome by inverting alternative tiles, which has the effect of placing the right side of the
first plot next to the right side of the second plot and the left side of the second plot next to the left side
of the third, so all contiguous areas belong to the same side of the roll and, hence, have the same
length. This is a feature that all RIPs have available.
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7 Troubleshoot substrate issues

The substrate cannot be loaded successfully
Here are some suggestions to try if you cannot load the substrate successfully.

● Reread the loading instructions in the User's guide, and make sure that you are following them.

● When loading a textile substrate, remember to use the loading accessory, and select Load with
accessory in the front panel.

● If automatic loading is unsuccessful, try manual loading instead.

● The substrate might be loaded at an angle (skewed or mislocated). Make sure that the right edge of the
substrate is aligned with the roll on the input spindle.

● The substrate might be crumpled or warped, or have irregular edges.

● If the substrate jams in the substrate path to the platen, the leading edge of the substrate might not be
straight or clean. Remove the initial 2 cm (1 in) of substrate from the roll and try again. This might be
necessary even with a new roll of substrate.

● Make sure that the spindle is correctly inserted.

● Make sure that the substrate is correctly loaded on the spindle, and that it loads over the roll towards
you.

● Make sure that the substrate is wound tightly.

The substrate is mispositioned

If you see the above display on the front panel, proceed as follows.

1. Lift the substrate lever.

2. Manually reposition the substrate on the platen.
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3. Lower the substrate lever.

4. Repeat the above steps until the front panel displays the Ready message.

The substrate has jammed
When a jam occurs, the Possible substrate jam message usually appears in the front panel, with one of
several error codes (see Front-panel error messages on page 79).

If you are trying to load a very thin or very thick substrate, or a textile, remember to follow the special
procedure described in the User's guide for loading such substrates.

Check the substrate path
● This problem can occur when a roll has finished and the end of the roll is stuck to the cardboard core. If

this has happened, cut the end of the roll away from the core. Then feed the substrate through the
printer, and load a new roll.

● Otherwise, follow the procedure described under Check the printhead path on page 64

Check the printhead path
1. Turn off the printer at the front panel, then also switch off the power switch at the rear.

2. Unlock and open the printer window.

3. Cut the substrate where it enters the printer, and rewind the input roll.

4. Wait for the printer to cool down to room temperature.
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5. Try to move the printhead carriage out of the way.

6. Lift the substrate-adjustment lever as far up as it will go.

7. Carefully remove as much as possible of the jammed substrate from the top of the printer. Cut the
substrate if necessary.

CAUTION: Try to avoid pulling the substrate out from the input path, because this reverses the normal
direction of movement, and could damage printer parts.

8. Lower the substrate-adjustment lever.

9. Make sure that there are no pieces of substrate left in the printer. In particular, check in and under the
curing module, and in the substrate path.

10. Close and lock the window.

11. Turn on the printer.

12. Reload the roll.

13. If some substrate continues to cause an obstruction within the printer, it can often be cleared by loading
a rigid substrate type into the printer.

14. If you find that you have print-quality problems after a jam, try realigning the printheads. See Align the
printheads on page 11.

Avoiding substrate jams
Substrate jams may be caused by loading the substrate with too much skew: do not ignore the warning
message that appears during the loading process in this case.
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They may also be caused by not enough vacuum suction in the printing zone. If you decide to increase the
suction, do not exceed the following limits: 20 mmH2O for banners, 35 mmH2O for vinyl, and 50 mmH2O for
other substrate families.

If you experience jams only at the beginning of a print, try the following suggestions.

● Disable the automatic cutter.

● Go to the front panel and select the  icon, then Substrate handling options > Extra bottom margin.
Set the margin to 100 mm. If that is not enough, try 150 or 200 mm. This extra margin will apply only to
jobs that start printing when the printer is idle and when the cutter is disabled.

● Increase the vacuum level in steps of 10 mmH2O. Do not exceed the following limits: 20 mmH2O for
banners, 35 mmH2O for vinyl, and 50 mmH2O for other substrate families.

● Decrease the warm-up drying temperature in steps of 5°C.

● Decrease the warm-up curing temperature in steps of 5°C.

● Increase the number of passes.

● Make sure that the substrate is stored in the same room in which the printer is located.

The substrate is deformed or wrinkled
If your substrate is deformed or wrinkled by the drying and curing process, change the temperature settings
before printing the next job, and advance the substrate, using the Move Substrate key on the front panel, so
that the next job will be printed on undamaged substrate.

If the problem appears only at the beginning of the print, try the following suggestions.

● Disable the automatic cutter.

● Go to the front panel and select the  icon, then Substrate handling options > Extra bottom margin.
Set the margin to 100 mm. If that is not enough, try 150 or 200 mm. This extra margin will apply only to
jobs that start printing when the printer is idle and when the cutter is disabled.

● Increase the vacuum level in steps of 10 mmH2O. Do not exceed the following limits: 20 mmH2O for
banners, 35 mmH2O for vinyl, and 50 mmH2O for other substrate families.

● Decrease the warm-up drying temperature in steps of 5°C.

● Decrease the warm-up curing temperature in steps of 5°C.

● Increase the number of passes.

● Make sure that the substrate is stored in the same room in which the printer is located.

The substrate has shrunk or expanded
During the printing process, some substrates may shrink, while others may expand. If this happens, the
dimensions of the print will not be correct.

As a general rule, you can expect the following percentages of shrinkage:

● Photorealistic: less than 0.4%

● Paper-solvent, Paper-aqueous: less than 0.5%

● Self-adhesive: less than 1.2%

● Banner: less than 3% shrinkage (if you disable the substrate-advance sensor, less than 7%)
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The framing problem may be solved by printing a sample and adjusting the size of the image in the RIP. You
may reuse this value for all your future prints with the same substrate, although special care must be taken
when using banners, as the shrinkage may vary up to 1% depending on the amount of ink used in the print.

You can expect the following variations from one print to another:

● Photorealistic, Paper-solvent, Paper-aqueous: less than 0.4%

● Self-adhesive: less than 0.7%

● Banner: less than 1%

To solve the tiling problem and improve the repeatability of the printed size, you are recommended to ensure
that the substrate-advance sensor is enabled in the RIP's substrate preset, as this will improve the stability
of the prints over time. You are also recommended to tile together areas with similar amounts of ink. If this is
not possible, print the areas with different amounts of ink as different jobs and modify the length of the job
with less ink in the RIP to match its size with the job with high ink content.

Some RIPs may provide a scaling option that allows you to compensate easily for substrate shrinkage or
expansion; see your RIP documentation.

The substrate has bow deformation
The following substrates may suffer from bow deformation during printing, as a result of which the print will
appear curved.

● Self-adhesive vinyl substrates (some specific calendared vinyls only)

● Cellulose-based poster papers with no backing nor coating, including HP Photorealistic

This deformation may be particularly noticeable in the following applications.

● Printing images that will later be cut automatically or manually. When there is bow deformation, cutters
that are aligned on the sides may lose alignment in the center.

● Poster printing, if the poster is framed or mounted on a straight surface.

The example below shows an original image, the substrate suffering from bow deformation, and the
resulting print, also suffering from bow deformation.

You can use the straightness optimization option in the front panel, or in your RIP software, to compensate
for this effect and restore the original shape of your image.

At the front panel, select the  icon, then select Image quality maintenance > Straightness optimization,
and select a correction value from –15 to +15.

The chosen value should represent the vertical distance in millimeters that the centre of the substrate has
moved with respect to the left and right edges. If the deformation moves the center of the substrate in the
direction of substrate advance, the correction value should be negative; if in the reverse direction, the
correction value should be positive. In practice, the required correction value is normally negative.
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TIP: You can use the diagnostic image provided in http://IPaddress/hp/device/webAccess/diagnostic/
StraightnessOptimizationPlot.pdf (where IPaddress is the IP address of your printer) to help you to
determine the correct value to apply.

The automatic cutter does not work
The automatic cutter is turned off in any of the following cases.

● When it has been manually disabled from the front panel: Select the  icon, then Substrate handling
options > Disable cutter.

● When printing on some particularly heavy substrate types, which it cannot cut.

● When the take-up reel is enabled.

TIP: You can disable the take-up reel from the front panel by selecting the  icon, then Take-up reel
> Disable take-up reel.

● During double-sided printing.

Take-up reel substrate jam
If the substrate is severely damaged on the take-up reel spindle, do not use the printer's cutter to cut and
remove the substrate. Instead, cut the substrate manually as close as possible to the printer window, then
remove the roll.

If the problem remains after removing the substrate jam, unload the take-up reel from the front panel and
load it again.

Take-up reel does not wind
Predictably, if the take-up reel is not winding as anticipated, the printed output is likely to end up on the
floor. If the printer recognizes a problem with the take-up reel, it interrupts the print job until the issue is
corrected. If the printer does not recognize a problem, the job continues to print. The following table
highlights possible issues and solutions.

Take-up reel LED status Issue Print job interrupted? Possible cause Possible solution

Blinking quickly Take-up reel is not
winding

Yes The sensor beam was
blocked for more than 3
seconds.

Make sure that the take-
up reel sensors are not
blocked by a strip of
substrate or any objects.
See the following
graphic. Make sure that
the collection bin is
placed behind the foot
brace.

Also ensure that the
take-up reel power
switch is in the On
position.

Blinking slowly Take-up reel is not
winding

No The sensor cables are
loose or unplugged.

Ensure that the sensor
cables are correctly
secured.
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Take-up reel LED status Issue Print job interrupted? Possible cause Possible solution

Solid red Take-up reel is not
winding

No There is too much
resistance on the take-
up reel motor.

Ensure that the
substrate is not winding
too tightly. A loop-
shaping core should be
inserted and hanging as
shown in the User's
guide.

Solid green Take-up reel is not
winding

No The take-up reel power
switch is in the Off
position

Ensure that the take-up
reel power switch is in
the On position.

Solid green Take-up reel is winding
in the wrong direction

No The take-up reel wind-
direction switch is in the
wrong winding position.

After 3 seconds, the
printer recognizes the
problem and interrupts
the print job. See the
first error listed in this
table.

Flip the take-up reel
wind-direction switch to
the correct position.

The following graphic shows the take-up reel sensors and cable.

1. Take-up reel sensor

2. Take-up reel sensor and cable housing unit
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8 Troubleshoot ink-system issues

Ink maintenance kit needs to be installed
If the front panel tells you that the ink maintenance kit needs to be installed, it means that the kit has not
been installed in your printer. Perform the normal procedure for replacing the ink maintenance kit (see
Replace the ink maintenance kit on page 27), except that you will not need to remove the old kit.

Cannot insert an ink cartridge
1. Check that you have the correct type of cartridge (model number).

2. Check that the colored label on the cartridge is the same color as the label on the slot.

3. Check that the cartridge is correctly oriented, the arrow on the front of the ink cartridge should face
upwards.

CAUTION: Never clean inside the ink cartridge slots.

Cannot insert a printhead
1. Check that you have the correct type of printhead (model number).

2. Check that you have removed the orange protective caps from the printhead.

3. Check that the colored label on the printhead is the same color as the label on the slot.

4. Check that the printhead is correctly oriented (compare with the others).

5. Check that you have closed and latched the printhead cover.

Cannot insert the printhead cleaning cartridge
Check that the printhead cleaning cartridge has the correct model number and is correctly oriented.

Front panel recommends reseating or replacing a printhead
1. Remove the printhead and check that it is free from physical damage and from ink stains on the

electrical connections.

2. If necessary, clean the electrical connections between the printhead and the carriage. See Clean the
electrical connections on a printhead on page 13.

3. Reinsert the printhead into the carriage and check the front panel message.

4. If the problem persists, insert a new printhead.
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Clean the printheads
Periodic printhead cleaning is performed automatically, as long as the printer is kept turned on. However,
you should clean the printheads if you are experiencing poor image quality and cannot resolve the issues by
other methods. This ensures that there is fresh ink in the nozzles and helps to prevents nozzle clogs.

If you have printed the printhead status plot, you know which colors are failing. Clean the pair of printheads
that are not performing adequately. If you are not sure which printheads to clean, clean all of the printheads.

To clean the printheads, go to the printer's front panel and select the  icon, select Image quality
maintenance > Clean printheads, then select which printheads you want to clean. You can clean all of the
printheads or only some of them. The choices are as follows.

● Print test plot

● Clean all

● Clean LC-C

● Clean Y-MK

● Clean LM-M

Cleaning all printheads takes about 5 minutes. Cleaning any two printheads takes about 3 minutes.

NOTE: Cleaning all printheads uses more ink than cleaning a single pair.

Align the printheads
Precise alignment between printheads is essential for color accuracy, smooth color transitions, and sharp
edges in graphical elements. Your printer has an automatic printhead alignment process which runs
whenever a printhead has been reseated or replaced.

In the case of a substrate jam, if you have used a custom substrate, or if you are experiencing problems with
color accuracy; you might need to align the printheads. See Align the printheads on page 11.

NOTE: If you experience a substrate jam, HP recommends that you reseat and align the printheads.

TIP: Use the same substrate you intend to print on to align the printheads.

WARNING! Colored substrates, glossy canvas, and transparent materials such as translucent bond, clear
film, tracing paper, and vellum are not suitable for aligning the printheads. However, if you must perform
printhead alignment with a material that is not supported, make sure you use a material with the same
thickness as the material you are going to use for printing.

Reinsert printheads procedure
1. If the printhead alignment process is running and the wrong substrate is loaded, press the Cancel

button on the front panel.

CAUTION: Do not print if the printhead alignment process has been canceled.

2. Load the substrate you want to use. Photo paper is recommended for the best results.

WARNING! Colored substrates, glossy canvas, and transparent materials such as translucent bond,
clear film, tracing paper, and vellum are not suitable for aligning the printheads. However, if you must
perform printhead alignment with a material that is not supported, make sure you use a material with
the same thickness as the material you are going to use for printing.
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3. Remove and reinsert all of the printheads. See Replace a printhead on page 30. This starts the printhead
alignment process.

NOTE: Make sure the printer window is closed during printhead alignment.

4. The process takes about 6 minutes. Wait until the front panel shows that the process is complete before
using the printer.

NOTE: A calibration image is printed during the printhead alignment process. The front panel shows if
there were any errors in the process.

Image Quality Maintenance menu procedure
1. Load the substrate you want to use. Photo paper is recommended for the best results. Plain; bond; and

thin, coated substrates are acceptable, but provide marginal results.

WARNING! Colored substrates, glossy canvas, and transparent materials such as translucent bond,
clear film, tracing paper, and vellum are not suitable for aligning the printheads. However, if you must
perform printhead alignment with a material that is not supported, make sure you use a material with
the same thickness as the material you are going to use for printing.

2. Go to the front panel and select the  icon, then select Image quality maintenance > Align printheads
> Auto PH alignment. The printer verifies that a sufficient amount of substrate exists to perform
printhead alignment.

3. If the substrate type that is loaded is acceptable for printhead alignment, the printer performs the
alignment and prints an alignment pattern.

NOTE: Make sure the printer window is closed during printhead alignment.

4. The process takes about 5 minutes. Wait until the front panel shows that the process is complete before
using the printer.

Scan errors during alignment
If the alignment process fails, a Scanning problems message appears on the front panel. This indicates that
the alignment was not completed successfully. Therefore, the printheads are not aligned and the alignment
should be repeated before printing. The problem might be because of one of the following scenarios:
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● The type of substrate used in the printhead alignment process was not acceptable. Repeat the
alignment process using one of the recommended substrate types.

● The printheads are not clean. Clean the printheads. See Clean the printheads on page 72.

● The printer window was open during the printhead alignment process. Repeat the alignment process
with the printer window closed.

If the problem persists after following the recommended remedies, try replacing all of the printheads. If the
problem persists after replacing the printheads, a failure in the scanning system may exist.
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9 Troubleshoot other issues

The printer cannot get an IP address
If your network has no DHCP server, the printer cannot automatically retrieve an IP address. In this case, you
must set the printer's IP address manually, in the following way.

1. Select the  icon, then select Connectivity > Gigabit Ethernet > Modify configuration > TCP/ IP >
IPV4 settings > Config method > Manual.

2. From the IPV4 Settings menu, select Manual settings > IP address.

3. Enter the IP address that you wish to use, and press the OK key when finished.

Cannot access the Embedded Web Server
If you have not done so already, please read the instructions in the User's guide.

1. Go to the front panel and select the  icon.

2. Select Connectivity > Advanced > Embedded Web Server > Allow EWS > On.

3. Go to the front panel and select the  icon, then select Connectivity > Gigabit Ethernet > View
information.

4. The information should read: IP enabled: Yes. If it does not, you might need to use a different
connection.

If you still cannot access the Embedded Web Server, turn the printer off with the Power button on the front
panel and then turn it on again.

If you experience very slow progress while trying to access the Embedded Web Server, the problem could be
that you are using a proxy server. Try bypassing the proxy server and accessing the Embedded Web Server
directly.

● In Internet Explorer 6 for Windows, go to Tools > Internet Options > Connections > LAN Settings, and
select the Bypass proxy server for local addresses check box. Alternatively, for more precise control,
click the Advanced button and add the printer's IP address to the list of exceptions, for which the proxy
server is not used.

● In Firefox 3.0 for Windows, go to Tools > Options > Network > Connection > Settings, and select the
Direct connection to the Internet check box. Alternatively, when the Manual proxy configuration
check box is selected, add the printer's IP address to the list of exceptions, for which the proxy server is
not used.

● In Firefox 2.0 for Linux, go to Edit > Preferences > Network > Connection > Settings, and select the
Direct connection to the Internet check box. Alternatively, when the Manual proxy configuration
check box is selected, add the printer's IP address to the list of exceptions, for which the proxy server is
not used.
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The printer is not printing
Possible reasons why a file you have sent from your computer is not printing when expected, include the
following:

● There may be a problem with the electrical power. If the printer is not performing and the front panel
does not respond, check that the power switch at the rear is on, the residual current circuit breakers are
up, the power cable is correctly connected, and the electrical socket is providing power.

● Unusual electromagnetic phenomena may exist, such as strong electromagnetic fields or severe
electrical disturbances. Such occurrences can cause the printer to behave strangely, or even stop
working. Turn off the printer by using the Power button on the front panel, wait until the
electromagnetic environment has returned to normal, then turn the printer on again. If the problems
persist, call your service representative.

● One of the following substrate scenarios may exist:

◦ The substrate name that appears on the front panel does not reflect the substrate that is loaded in
the printer.

◦ There is not a sufficient amount of substrate on the loaded roll to print the entire job.

Under these conditions, one print job might be printed, while another print job is held in the print queue.
To resolve this issue, unload the roll from the printer and load a new roll, using the front panel to guide
you through the process.

The software program slows down or stalls while generating the
print job

Large quantities of data might be necessary to generate a high-quality large-format print job. This can cause
your software program to slow down significantly or stall. Lowering the print resolution may help to avoid
this scenario, however, lowering the print resolution reduces image quality.

The printer seems slow
Here are some possible explanations.

● If you request the highest possible print quality in the RIP, printing will be relatively slow compared with
draft-quality printing.

● Ensure that the substrate loaded in the printer belongs to the substrate family that appears on the
front panel.

● Are the printheads in good condition? Printing time tends to increase when a printhead needs cleaning.
Check the printhead status on the front panel or through the Embedded Web Server. Clean or replace
printheads if necessary.

● Does your image contain high-density black fills? That may increase printing time.

● If your printer is connected to a network, check the following points.

◦ Ensure that all components used in the network (network interface cards, routers, switches and
cables) are capable of high-speed operation. All network switches should be Gigabit switches or at
least 100 Mbits/sec (100 baseT); all network cables should be CAT-5e or better.

◦ Ensure that all network cables are well connected and in good physical condition. Damaged cables
and poor connections at the Ethernet sockets can seriously degrade performance.

◦ Is there a lot of traffic from other devices on the network?
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◦ Ensure that no other device on the network is trying to use the same IP address as the printer.

◦ Ensure that the Ethernet link speed is Gigabit (or 100 baseT full duplex if Gigabit is not possible in
your network). This is normally best achieved by setting the link speed to Automatic in the
Embedded Web Server. Ensure that the Ethernet switch or router to which the printer is connected
is also configured for automatic link speed (this is normally the default case).

◦ Having checked the network connection to the printer, make similar checks (on cables, link speed
settings and duplicated IP addresses) on the connection between the computer and the Ethernet
switch or router.

◦ Remember that firewalls and other software running on the computer may reduce the network
speed significantly.

See also the information about printer states in the User's guide.

Cannot access files on the hard disk
If you have trouble accessing files on the printer's hard disk, consider running a file system check. See Check
the file system on page 7.

Communication failures between computer and printer
Some symptoms are:

● The front-panel display does not show the Receiving message when you have sent an image to the
printer.

● Your computer shows an error message when you try to print, such as error 61:09 or 63:05. See Front-
panel error messages on page 79.

● Your computer or printer stalls when transferring data.

To solve a communication problem:

● Make sure that you have selected the correct printer in your RIP.

● Remember that large images usually require more time to receive, process, and print.

● If the printer is connected to your computer through any other intermediate devices, such as switch
boxes, buffer boxes, cable adapters, or cable converters, remove the intermediate device and try
connecting the printer directly to your computer.

● Try another interface cable.

● Try changing the I/O timeout, which specifies the time that an idle connection is allowed to remain open
when the printer is waiting for a remote computer. The default value is 30 seconds. If set to zero, the
timeout is disabled and the connection is allowed to remain open indefinitely. To change the I/O
timeout, go to the front panel and select the  icon, then Connectivity > Advanced > Select I/O
timeout.

The platen rollers squeak
If you notice that the platen rollers are squeaking, call HP support for help: http://welcome.hp.com/country/
us/en/wwcontact_us.html
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10 Front-panel error messages

Under certain circumstances, a front-panel error message appears. Follow the advice in the Recommendation
column to resolve the error.

If an error message appears on the front panel that is not included in this list, and you are in doubt of the
correct response, call your service representative. See When you need help on page 85.

Table 10-1  Text messages

Message Recommendation

[Color] cartridge has expired Replace the cartridge. See When you need help on page 85.

[Color] cartridge is missing Insert a cartridge of the correct color. See When you need help on page 85.

[Color] cartridge is out of ink Replace the cartridge. See When you need help on page 85.

[Color] printhead #[n] error: not present Insert the correct printhead. See When you need help on page 85.

[Color] printhead #[n] error: please
remove

Remove the incorrect printhead and insert a new printhead of the correct type (color and
number). See When you need help on page 85.

[Color] printhead #[n] error: replace Remove and reinsert the same printhead, or try cleaning the electrical connections. See
Clean the electrical connections on a printhead on page 13. If the problem persists,
remove the non-functional printhead and insert a new printhead. See Replace a
printhead on page 30.

[Color] printhead #[n] error: reseat Remove and reinsert the printhead; try cleaning the electrical connections. See Clean the
electrical connections on a printhead on page 13. If necessary, insert a new printhead.
See Front panel recommends reseating or replacing a printhead on page 71.

[Color] printhead #[n] out of warranty The printhead's warranty has ended, because of the length of time it has been in
operation or because of the volume of ink used. See the Legal Information.

[Color] printhead #[n] warranty warning The printhead's warranty may be invalidated by the use of non-HP ink. See the Legal
Information.

[Warning] internal failure: Unable to create
print

The internal print files are not available in the printer. Load the internal print files
through the Embedded Web Server.

Cable is disconnected. Repair ink
maintenance kit

At the front panel, select the  icon, then select Repair ink mainten. kit, and follow
the instructions on the front panel.

Clean OMAS or disable it at the RIP Either the substrate-advance sensor is covered with dried ink or dust and needs to be
cleaned, or the current substrate is not supported by the substrate-advance sensor, and
you are advised to disable it for this substrate.

Ink maint kit almost full Make sure that you have a new ink maintenance kit available.

Ink maint kit full Replace the ink maintenance kit. See Replace the ink maintenance kit on page 27.

Ink maintenance kit is not correct. Repair The ink filter cover is open. Close it.

Ink maintenance kit not installed The installation of the ink maintenance kit has been cancelled. To complete the
installation, see Replace the ink maintenance kit on page 27.

IO error Restart the printer. If the problem persists, call your service representative. See When
you need help on page 85.
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Table 10-1  Text messages (continued)

Message Recommendation

IO warning Try again; if the problem persists, call your service representative. See When you need
help on page 85.

PDL Error: Ink system not ready Clean the printheads. See Clean the printheads on page 72.

PDL Error: Job clipped The image is too large for the substrate or for the printer. Load larger substrate if
possible, or reduce the image size.

PDL Error: memory full Restart the printer and try resending the job; if necessary, reduce the complexity of the
job.

PDL Error: out of substrate Load more substrate.

PDL Error: parsing error The print job is unintelligible to the printer. Try to recreate and resend it. Check your
cable connections.

PDL Error: print mode error The substrate type or print quality specified for the job are incorrect. Change the loaded
substrate type or the print settings.

PDL Error: printing error Try sending the job again.

PDL Error: virtual memory full Restart the printer and try resending the job; if necessary, reduce the complexity of the
job.

PH cleaning kit almost full Make sure that you have a new printhead cleaning kit available.

PH cleaning kit full Replace the printhead cleaning kit. See Replace the printhead cleaning kit on page 35.

Replace [color] cartridge Replace the cartridge. See When you need help on page 85.

Reseat [color] cartridge Remove and reinsert the same cartridge. See When you need help on page 85.

Update: failed. Invalid file Make sure that you have selected the correct firmware update file. Then try again to
perform the update.

Under certain circumstances, a front-panel numeric error message appears. Follow the advice in the
Recommendation column to resolve the error.

If an error message appears on the front panel that is not included in this list, turn off the printer and then
turn it back on. If the problem persists, call your service representative. See When you need help
on page 85.

Table 10-2  Numeric error messages

Error code Recommendation

15.01:00 The printer is unable to warm up within a preset time limit. Check that the ambient temperature and
input voltage are within printer specifications. If the problem persists, call your service
representative. See When you need help on page 85.

15.02:00 The printer is unable to cool down within a preset time limit. Check that the ambient temperature is
within printer specifications. Check that all fans are working and unblocked. If the problem persists,
call your service representative. See When you need help on page 85.

15.03:00 Excessive heat in the drying module. Check that all fans are working and unblocked. If the problem
persists, call your service representative. See When you need help on page 85.

15.04:00 Insufficient heat in the drying module. Check that the ambient temperature is within printer
specifications. If the problem persists, call your service representative. See When you need help
on page 85.

15.05:00 Infrared sensor error. Check that all fans are working and unblocked. If the problem persists, call
your service representative. See When you need help on page 85.
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Table 10-2  Numeric error messages (continued)

Error code Recommendation

15.06:00 The drying module has been operating at maximum power for too long. Check that the ink quantity
is not too high. Check that the ambient temperature is within printer specifications. If the problem
persists, call your service representative. See When you need help on page 85.

16.01:00 The printer is unable to warm up within a preset time limit. Check that the ambient temperature and
input voltage are within printer specifications. If the problem persists, call your service
representative. See When you need help on page 85.

16.02:00 The printer is unable to cool down within a preset time limit. Check that the ambient temperature is
within printer specifications. Check that all fans are working and unblocked. If the problem persists,
call your service representative. See When you need help on page 85.

16.03:00 Excessive heat in the curing module. Check that all fans are working and unblocked. If the problem
persists, call your service representative. See When you need help on page 85.

16.04:00 Insufficient heat in the curing module. Check that the ambient temperature is within printer
specifications. If the problem persists, call your service representative. See When you need help
on page 85.

16.05:00 Infrared sensor error. Check that all fans are working and unblocked. If the problem persists, call
your service representative. See When you need help on page 85.

16.06:00 The curing module has been operating at maximum power for too long. Check that the ink density is
not too high. Check that the ambient temperature is within printer specifications. If the problem
persists, call your service representative. See When you need help on page 85.

21:03 Turn off the printer using the front panel and the power switch at the rear. Disconnect the power
cords. Reconnect the power cords and turn the printer on again. If the problem persists, call your
service representative. See When you need help on page 85.

21.2:10 Printhead cleaning cartridge error. Turn the printer off, remove the printhead cleaning cartridge and
check whether the cloth can be manually advanced by using the white gears on its right-hand side.
If so, reinsert it. If not, try a new printhead cleaning cartridge. Turn the printer on. If the problem
persists, call your service representative. See When you need help on page 85.

24:03 The setup procedure has not been completed. Restart the printer, then restart the setup procedure
from the beginning.

26.n:01 (where n = the ink
cartridge number)

Remove the ink cartridge and reinstall it in the printer. If the error persists, replace the cartridge
with a new one. If the problem persists, call your service representative. See When you need help
on page 85.

29:01 The printhead cleaning cartridge is not inserted correctly. Open the printhead cleaning cartridge
door on the right side of the printer, make sure that the printhead cleaning cartridge is correctly
seated, then close the door. If the problem persists, replace the printhead cleaning cartridge. If the
problem persists, call your service representative. See When you need help on page 85.

32:01 The take-up reel is disconnected. If you want to use the take-up reel, turn off the printer and ensure
that all take-up reel cables are connected (sensor cables, printer cable). If you do not want to use it,
you may need to unload the substrate manually from the take-up reel. Remember to cut the paper
first, either manually or by pressing the Move substrate key.

32:01.1 This error occurs when there is a small amount of substrate printed, less than 79 in (200 cm) long.
Check that there is no obstacle between the take-up reel optical sensors; that the substrate is
attached to the take-up reel spindle; and that the take-up reel switch is in the correct position. If
necessary, use the take-up reel arrow keys to wind the substrate; then press OK to resume printing.

32:01.2 This error occurs when there is a small amount of substrate printed, less than 70 in (178 cm) long.
The take-up reel sensor detects that the loop shaper is (incorrectly) at the bottom of its path, even
though the spindle motor has been rotating for more than 3 seconds. The most probable cause of
this error is that you have forgotten to set the switch direction or tape the substrate to the spindle
core, when the substrate reaches the floor and blocks the take-up reel's infrared sensors. Check
that there is no obstacle between the take-up reel optical sensors; that the substrate is attached to
the take-up reel spindle; and that the take-up reel switch is in the correct position. If necessary, use
the take-up reel arrow keys to wind the substrate; then press OK to resume printing.
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Table 10-2  Numeric error messages (continued)

Error code Recommendation

32:02 This error occurs during printer initialization, to warn you that the take-up reel has been
disconnected while the printer was turned off. It also occurs if you try to enable the take-up reel,
but it is not connected to the printer. Connect the take-up reel to the printer and press OK to
continue.

41:03 Turn off the printer using the front panel and the power switch at the rear. Disconnect the power
cords. Open the window and check for any visible obstacles restricting the movement of the drive
roller. If there is a wrinkled mass of substrate in the substrate path, lift the substrate adjustment
lever and clear the obstruction. Reconnect the power cords and turn the printer on again. If the
problem persists, call your service representative. See When you need help on page 85.

42:03 Turn off the printer using the front panel and the power switch at the rear. Disconnect the power
cords. Open the window and check for any visible obstacles restricting the movement of the
printhead carriage. If there is a wrinkled mass of substrate blocking the carriage, lift the substrate
adjustment lever and clear the obstruction. Reconnect the power cords and turn the printer on
again. If the problem persists, call your service representative. See When you need help
on page 85.

44:10 The waste management fan has failed.

44.1:01 The waste management system cable is disconnected; the cable from the printer cover to the
interconnect could be disconnected too.

44.2:01 A switch has failed. Check the waste management system: the ink tube assembly should be
connected and the ink filter door closed.

44.3:00 There is a short circuit in the waste management system cable, and perhaps also in the
interconnect.

44.4:01 There is noise in the signal of the waste management system. Check that the connector is properly
connected.

46:03 Turn off the printer using the front panel and the power switch at the rear. Disconnect the power
cords. Reconnect the power cords and turn the printer on again. If the problem persists, call your
service representative. See When you need help on page 85.

61:01 The file format is incorrect and the printer cannot process the job. Try the following remedies:

● Turn off the printer by using the Power key on the front panel and the power switch at the
back of the printer. Disconnect the power cord, then reconnect the power cord and turn on the
printer.

● Make sure that the RIP supports the printer and that the printer driver is installed in the RIP.

● Resubmit the file to the printer.

● Check that your printer firmware is up to date. See Firmware update on page 9.

● Check that you are using the latest version of your RIP.

If the problem persists, call your service representative. See When you need help on page 85.

61:09 The RIP is unable to communicate with the printer. Check that all relevant cables are properly
connected, and check whether the RIP has displayed any error message.

63:04 An input/output problem has occurred with the network card. Try the following remedies:

● Make sure that the network cable is correctly connected to the network card.

● Check that your printer firmware is up to date. See Firmware update on page 9.

If the problem persists, call your service representative. See When you need help on page 85.
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Table 10-2  Numeric error messages (continued)

Error code Recommendation

63:05 The job is reaching the printer too slowly. The printer cancels the job if there are long pauses of
more than 20 s. Try the following remedies:

● Make sure that a 1 Gigabit Ethernet card is correctly installed in the computer with the RIP.

● Check the RIP for any error messages. Check that the computer with the RIP is working
correctly and has the minimum specification required by the RIP. Check that the hard disk is
neither full nor excessively fragmented.

● Check whether the option RIP while printing is enabled. This option can cause slow printing if
the computer is not sufficiently powerful.

● Try reducing the resolution of the job or increasing the number of passes.

73:03 Turn off the printer using the front panel and the power switch at the rear. Disconnect the power
cords. Reconnect the power cords and turn the printer on again. Check that the printer has the latest
firmware version. If not, update the firmware to the latest version. If the problem persists, call your
service representative. See When you need help on page 85.

74:01 An error occurred when uploading the firmware update file. Try the following remedies:

● Turn off the printer by using the Power key on the front panel and the power switch at the
back of the printer. Disconnect the power cord, then reconnect the power cord and turn on the
printer.

● Try again to upload the firmware update file to the printer. See Firmware update on page 9.

If the problem persists, call your service representative. See When you need help on page 85.

76:03 A “disk out of space” has occurred. Try the following remedies:

● Turn off the printer by using the Power key on the front panel and the power switch at the
back of the printer. Disconnect the power cord, then reconnect the power cord and turn on the
printer.

● Resubmit the file to the printer.

If the problem persists, call your service representative. See When you need help on page 85.

77:04 An Embedded Web Server internal software error has occurred. Try the following remedies:

● Turn off the printer by using the Power key on the front panel and the power switch at the
back of the printer. Disconnect the power cord, then reconnect the power cord and turn on the
printer.

● Check that your printer firmware is up to date. See Firmware update on page 9.

If the problem persists, call your service representative. See When you need help on page 85.

78.1:04 The printer has no substrate preset for this substrate. Follow the firmware upgrade procedure to
update the printer with the latest substrate presets.

78.2:01 The end of roll has been detected. If this is not the case, unload and reload the substrate.

81:01, 81:03 Open the printer window and make sure that there are no obstacles restricting the movement of the
drive roller. If the substrate has jammed and is restricting the movement of the drive roller, see The
substrate has jammed on page 64. If the problem persists, call your service representative. See
When you need help on page 85.

82:01 There may be a substrate jam, or a dirty carriage reflector. Try cleaning the carriage reflector; if the
problem persists, see The substrate has jammed on page 64.

86:01 Open the window and check for any visible obstacles restricting the movement of the printhead
carriage. If there is a wrinkled mass of substrate blocking the carriage, lift the substrate adjustment
lever and clear the obstruction. If the problem persists, call your service representative. See When
you need help on page 85.

98:03 One or more printheads is malfunctioning; use the printhead status plot to find out which. See Use
the printhead status plot on page 53.
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Printer logs
If you go to the front panel and select the  icon, then Printer logs, you can choose to display on the front
panel a log of recent system errors, warnings, or printhead or ink cartridge events.
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11 When you need help

Introduction
HP Customer Care offers award-winning support to ensure that you get the most from your HP Designjet. HP
Customer Care provides comprehensive, proven support expertise and new technologies to give you unique
end-to-end support. Services include setup and installation, troubleshooting tools, warranty upgrades,
repair and exchange services, phone and Web support, software updates, and self-maintenance services. For
more information about HP Customer Care, go to: http://www.hp.com/go/graphic-arts/.

Documentation
The following documents are provided with your printer, and can also be downloaded from
http://www.hp.com/go/L26500/manuals/ and http://www.hp.com/go/L26100/manuals/.

● Site preparation guide

● Installation guide

● User's guide

● Maintenance and troubleshooting guide (this document)

● Legal information

Customer Self Repair
HP's Customer Self Repair program offers our customers the fastest service under either warranty or
contract. It enables HP to ship replacement parts directly to you (the end user) so that you can replace them.
Using this program, you can replace parts at your own convenience.

Convenient, easy to use

● An HP Support Specialist will diagnose and assess whether a replacement part is required to address a
defective hardware component.

● Replacement parts are express-shipped; most in-stock parts are shipped the very same day you contact
HP.

● Available for most HP products currently under warranty or contract.

● Available in most countries.

For more information about Customer Self Repair, see http://www.hp.com/go/selfrepair/.

HP Customer Care Centers
Help is available to you by telephone. What to do before you call:
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● Review the troubleshooting suggestions in this guide.

● Review your RIP's documentation, if relevant.

● Please have the following information available:

◦ The printer you are using: the product number, the serial number and the service ID

NOTE: This information is available from the front panel: select the  icon, then View printer
information. You may also find it on a label at the rear of the printer.

◦ If there is an error code on the front panel, note it down; see Front-panel error messages
on page 79

◦ The RIP you are using, and its version number

◦ The software application you are using, and its version number

◦ The text displayed by the Embedded Web Server when you select Help > About

Telephone number
Your HP Support telephone number is available on the Web: please visit http://welcome.hp.com/country/us/
en/wwcontact_us.html.

Service information
The printer can produce on request a list of many aspects of its current status, some of which may be useful
to a service engineer trying to fix a problem. There are two different ways to request this list:

● In the Embedded Web Server, select the Support tab and then Service support > Printer information.

● From any computer with Internet access, enter the URL of your printer into a Web browser, followed
by /hp/device/webAccess/allServicePlot.htm. For instance, if the URL of your printer is
http://123.123.123.123, enter http://123.123.123.123/hp/device/webAccess/
allServicePlot.htm.

You can request the whole list, which takes a significant time to generate; or you can request specific parts of
it. If in doubt, you are recommended to request the whole list (select All pages).

If you need to send the list by e-mail, you can save the page as a file from your Web browser, and later send
the file. Alternatively, from Internet Explorer you can send the page directly: select File > Send > Page by E-
mail.
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A Summary of common printing problems

This is a table of common problems and the RIP parameters that can be changed in order to solve the
problem. Some possible side-effects are also shown. For a more detailed treatment of any particular
problem, please see the relevant chapter in this guide.

Problem Parameter Change Possible side-effects

Durability problems, ink smudges or
oily finish

Curing temperature Increase Substrate jam, substrate damage,
ink smears

 Number of passes Increase Slower printing

Substrate jam, substrate damage,
ink smears

Curing temperature Decrease Less durability (smudges), oily finish

 Vacuum (and disable cutter) Increase Substrate skew

 Top and/or bottom margins Increase Substrate waste

 Drying temperature Decrease Coalescence, banding, less
durability (smudges), oily finish

Horizontal or thin vertical banding
in saturated area fills

Drying temperature Increase Substrate jam, substrate damage,
ink smears

 Ink limits Decrease
(depends on RIP)

Reduced color gamut

 Number of passes Increase Slower printing

 Modify color separations and dark
color generation

  

Graininess, color misregistration or
lack of sharpness

Align printheads   

 Calibrate substrate advance   

Black areas look hazy or image
gloss is not uniform

Modify color separations and dark
color generation

  

 Drying temperature Increase Substrate jam, substrate damage,
ink smears

 Number of passes Increase Slower printing

 Curing temperature Decrease Less durability (smudges), oily finish
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